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General Information 
NEMS-A. Instructions for Use. 

For software version: 2.7.9.0 Software release date: 01.02.2026 

For device models: Norav NR Series, Norav PC-ECG 1200 Series, NBP-24 NG, NBP One, Oscar 2, NSpiro™ Spirometry, MiniSpir 

Document number (D/N): NV-400.2790.050   Revision: 02 Date of document release: 25.02.2026 
 

Item(s) Basic UDI-DI 
Software: NEMS-A v2.7.9.0 426049856DE55252NMKEYVQ 
Devices: Norav NR Series 426049856DE55252NMAMBTG 
Devices: Norav PC-ECG 1200 Series 426049856DE55252NMDECT9 
Devices: NR-1207-E and NR-1207-3 426049856DE55252NMNRSX2 
Devices: NBP One 0840935100000000000250D92 
Devices: Oscar 2 084093510000000000002507E 
Devices: MiniSpir 805299032052-053D4 

Copyright Information 
This document and the software it describes are proprietary to Norav Medical and protected under copyright law. They may not be copied, 
reproduced, transmitted, or translated, in whole or in part, without prior written consent from Norav Medical. Unauthorized modifications to 
this document or the software may void regulatory compliance and manufacturer liability. 

The information in this document is for guidance only and is provided solely for the proper and safe use, maintenance, or servicing of the 
software described herein. This information is subject to change without notice and should not be construed as a commitment by Norav 
Medical. Norav Medical assumes no liability for errors or inaccuracies that may appear in this document. Norav Medical also assumes no 
responsibility for improper or illegal use of the software or for failure to follow the instructions, warnings, or intended use guidelines provided 
herein. 

The Windows® name is a registered trademark of Microsoft Corporation in the United States and other countries.  

All other trademarks mentioned are the property of their respective owners. 

The most recent version of this document can be downloaded from our website: https://www.noravmedical.com/support-center/ 

©2026, Norav Medical. All rights reserved. 

 

Manufacturer and Contact Information 

 
Manufactured by:  UK Responsible Person  Representative in Switzerland 
Norav Medical GmbH  MEDES LIMITED  Arazy Group Swiss GmbH 
Christof-Ruthof-Weg 10  5 Beaumont Gate  Bruderholzallee 53 
55252 Mainz-Kastel  Shenley Hill  4059 Basel 
Germany  Radlett, Hertfordshire WD7 7AR  Switzerland 
Phone: +49 6134-567983-0  England, UK  Phone: (+41) 33533 2267 
E-mail: info@norav.com  E-mail: medes@arazygroup.com   E-mail: swiss.ar@arazygroup.com 
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Compliance Information 
This product (software) complies with the applicable requirements of Regulation (EU) 2017/745 of the European Parliament and of 
the Council on medical devices, as well as the UK Medical Devices Regulations 2002 (Statutory Instruments 2002 No. 618 
Consumer Protection), as amended. 

   

This product (software) is intended for installation on equipment that meets the applicable edition of IEC 62368-1. Medical devices 
used in conjunction with this product must comply with the relevant IEC 60601 series standards, as appropriate. In addition, any 
electromagnetic interference generated by devices in this configuration must conform to Directive 2014/30/EU of the European 
Parliament and of the Council of 26 February 2014. 

⚠Caution: Federal Law restricts this device to sale by or on the order of a licensed physician or healthcare provider. 

Disclaimer 
This product (software) is intended solely as a decision support system for individuals who have received appropriate medical 
training, and must not be used as the sole basis for making clinical decisions pertaining to patient diagnosis, care, or 
management. Any application of medical information from the product, other than its original design or intended use, is not 
advised and is considered misuse of the product. 

Important Usage Notice 
Like in all medical (including but not limited to ECG) data processing systems, noise or artifacts may produce false-positive events. 
Therefore, patient data must be reviewed and edited only by a qualified technician or physician who has received appropriate 
training. Norav Medical and its staff shall not be held liable for patient data reviewed or edited by an unqualified person, or by a 
qualified person acting outside the scope of appropriate medical judgment. 

Norav Medical Limited Warranty 
Norav Medical products are warranted to be free from manufacturing and material defects for a period of two (2) years from the 
date of shipment by Norav Medical or an authorized dealer to the original purchaser.  

Expendable supply items, including but not limited to electrodes, lead wires, and patient cables, are excluded from this warranty. 
This warranty does not apply to any product that Norav Medical determines has been modified or damaged by the customer. 

Except for the express warranties stated above, Norav Medical disclaims all warranties, including implied warranties of 
merchantability and fitness. The stated express warranties are in lieu of all obligations or liabilities on the part of Norav Medical for 
any damages, including but not limited to special, incidental, indirect, or consequential damages, arising out of or in connection 
with the use or performance of Norav Medical products. 

Any action for breach of warranty must be commenced within one (1) year of the alleged breach or be forever barred. Any repairs 
made to the product that are not covered by this warranty shall be billed to the customer. 

For service or technical support, please contact your local supplier or Norav Medical. 
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Introduction 

Document Conventions 
Before working with the NEMS-A application, review this section to familiarize yourself with the recommended 
standards, labels, and practices used throughout this manual. These conventions are designed to ensure clarity, 
accuracy, and safety for both medical personnel and patients. 

Warnings Cautions and Notes 
Pay particular attention to specific points in a procedure when one of the following messages is displayed: 
 
 

 
Warning 

Warnings call attention to possible hazards involving potential damage or injury to 
persons. 

 
Caution 

Cautions refer to practices necessary to protect against potential damage to 
equipment or loss of equipment. Pay careful attention to instructions. 

 
Note 

Notes provide pertinent information to help obtain optimum software/system 
performance or signify an important step or procedure requiring special attention. 
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Abbreviations and Acronyms 

Equipment Symbols 
Symbol Description 

 

 

Type BF applied part 

 

 

Type CF applied part 

 

 

 
Class II equipment 

Abbreviation Meaning 

ABPM Ambulatory Blood Pressure Monitoring 

BP Blood Pressure 

ECG Electrocardiogram 

EMR Electronic Medical Record 

EMS ECG Management System 

GDT Gerätedatentransfer (device data transfer)  
A format to transfer data among medical devices and software systems. 

HRV Heart Rate Variability 

ID Patient Identification 

IFU Instructions For Use 

LP Late Potential 

LQTS Long QT Syndrome 

MI Myocardial Infarction 

NEMS Norav ECG Management System 

METS Metabolic Stress Estimation 

MRN Medical Record Number 

QT Time from the start of the Q wave to the end of the T wave 

Record Rest/Stress/Holter ECG/ABPM test 

SN Serial Number 

ST Segment The ST segment encompasses the region between the end of ventricular 
depolarization and beginning of ventricular repolarization on the ECG  
(see https://en.ecgpedia.org/wiki/ST_Morphology) 

USB Universal Serial Bus 

https://en.ecgpedia.org/wiki/ST_Morphology
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Intended Use 
NEMS-A Intended Use 
The NEMS-A Management System software is specifically designed for use by medical professionals and point-of-
care applications. It integrates seamlessly with local Norav databases, enabling efficient storage, retrieval, display, 
modification, and printing of high-resolution record data obtained from relevant devices. 
NEMS-A also functions as an archive system, enabling the management of tests and patients and providing real-
time status updates of tests, including those reports confirmed by a physician and unconfirmed reports. 
NEMS-A supports the creation of new patients, allows viewing of existing patients and their test records, enables 
opening tests using relevant Norav apps, and offers additional functionalities like test comparison and analysis. 

PC-ECG 1200 Intended Use 
ECG Intended Use 

ECG is intended to identify normal conditions, arrhythmia patterns, myocardial ischemia, rate abnormalities, or 
prognostic features in adults and pediatric populations. It is particularly useful for: 

• Patients with suspected cardiac abnormalities. 
• Populations at an age or period where routine baseline evaluation of ECG characteristics is essential. 

QT Analysis within PC-ECG 1200 aids in assessing long QT syndrome (LQTS), which, in certain cases, can be 
managed with pharmacological therapy. Additionally, QT dispersion measurement, representing the variance 
between maximal and minimal QT values, indicates ventricular repolarization homogeneity. 
PC-ECG 1200 has been tested to measure Heart Rate Variability (HRV) and Late Potential (LP) within a tolerance 
of 1 millisecond. The clinical significance of Heart Rate Variability and Late Potential, both features of the PC-
ECG 1200, should be assessed by a physician. 

Stress Testing Intended Use 
Stress testing, a primary method for diagnosing myocardial ischemia related to coronary artery disease, evaluates the 
heart muscle's contractile capacity during exercise, recorded via ECG. 
This testing is critical for patients experiencing angina pectoris, symptomatic of myocardial ischemia and indicative 
of reduced cardiac muscle blood supply. 
In stress testing, the contractile capability of the heart muscle is captured by ECG during patient exercise. The 
ECG monitors patient exercise on a bicycle, treadmill, or other devices, with activity levels set by predefined 
protocols. ECG signals are recorded for the rest, exercise, and recovery phases of the exercise protocol. The 
changes in ECG waveforms are compared with the resting ECG records to detect myocardial ischemia or coronary 
artery disease (CAD), evaluate ST segment depression, and monitor CAD treatment efficacy. The significance of 
observed ST segment changes, analyzed through a validated algorithm, must be determined by a physician. 

Holter NH-301 Intended Use 
The Holter NH-301 analysis system is intended for patients requiring ambulatory (Holter) recordings from 1 to 336 
hours. This recording is commonly used for: 

• Evaluation of symptoms suggesting arrhythmia or myocardial ischemia. 

• Documenting therapeutic interventions in individual patients or patient groups. 

• ST segment changes evaluation. 

• Patient's response assessment after resuming occupational or recreational activities, for example, post-
myocardial infarction or cardiac surgery. 

• Clinical and epidemiological research studies. 

The NH-301 Holter analysis system contains Heart Rate Variability (HRV) measurements. The clinical significance 
of HRV measurements should be determined by a physician. 
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NSpiro™ Intended Use 
NSpiro is a spirometry system for accurate measurements crucial in asthma management, detecting acute respiratory 
disorders, and pharmaceutical trials. 

The system can be used standalone or integrated with the Norav Medical ECG Management System (NEMS) for 
expanded functionality. NSpiro includes a powerful SQL database and offers optional interfaces for connectivity 
with various hospital information systems, supporting a wide range of clinical applications. 

MIR Spiro Intended Use 
MIR Spiro software is a database for managing spirometry and oximetry tests acquired from compatible spirometers. 
The connected spirometers carry out all the measurement functions and calculate spirometric and oximetric 
parameters. The software provides a series of parameters related to human respiratory function.  

This software is for medical or paramedical staff and must be used under the supervision of a physician. Moreover, it 
must be used and serviced by qualified personnel. This software is to be used at a doctor’s practice or hospital ward. 

ABPM Devices Intended Use 
The NBP One, Oscar 2, and NBP-24 NG are advanced noninvasive oscillometric ambulatory blood pressure 
monitoring (ABPM) devices intended for use with the NEMS-A system. These devices can record and display up to 
250 measurements or provide 24 hours of systolic and diastolic blood pressure and heart rate monitoring. 

They are intended for use as aids or adjuncts to diagnosis and treatment when measuring systolic and diastolic blood 
pressures over an extended period is necessary for adult and pediatric patients (over 4 years). These systems are 
intended solely for measurement, recording, and display purposes to assist licensed physicians in making diagnoses. 

Norav Recorder (NR) Intended Use 
The Norav NR series (hereafter referred to as “NR”) devices enable the capture of ECG waveforms with subsequent 
recording and/or data transmission to an external computer. 

The NR series devices are intended for executing: 

• Ambulatory Holter ECG 

• Ambulatory Event ECG 

• Resting ECG 

• Stress ECG 

• Telemetry ECG 

The following NR-series devices are compatible with the NEMS-A system and related applications: 

Figure 1. Norav Recorder Devices Intended Use - NR Feature Matrix 
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The NR series devices are indicated for use on patients who may be asymptomatic or who may experience transient 
symptoms suggesting conditions like arrhythmia or myocardial ischemia. They are used for evaluating therapeutic 
interventions, monitoring patients for ST segment changes, assessing patient responses to post-cardiac events, in 
clinical research, and for patients with pacemakers or requiring QT interval reporting. 

For more detailed information, please refer to the relevant NR device manual. 

The NR series devices are designed for use by medical clinical professionals who must instruct patients on their 
correct use, ensuring that patients clearly understand these instructions. 

MiniSpir Intended Use 
MiniSpir is a USB spirometer for real-time tests directly on a PC. The device is powered via an integrated USB cable, 
has no display or internal memory, and records data directly in the spirometry software. This device can be used 
exclusively with the Norav Medical ECG Management System (NEMS) for expanded functionality. 
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Overview 
This section provides an overview of the NEMS-A software package, detailing its contents and compatible 
applications. Each application utilizes certain devices and serves specific diagnostic functions and is integrated with 
the NEMS-A management system to enhance medical and diagnostic procedures. 

Norav Medical ECG Management System (NEMS-A) is a comprehensive management solution that consolidates 
studies and patient records into a single application. It automates workflow execution, data storage, and ECG 
display, thereby improving patient care while reducing processing times and costs. 

NEMS-A supports a wide range of cardiac medical devices and records, such as Resting ECG, Stress ECG, Holter 
ECG, Ambulatory Blood Pressure, Spirometry, as well as non-Norav PDF reports. 

Main Features 
• Patients management 

• Test Records management 

• Advanced engine enabling search through patients' data and Records 

• Holter and ABPM devices management 

• Managing Patient Groups, Referring Physicians, Technicians, and Reporting MD lists. 

Package Contents 
The NEMS-A package contains the following elements: 
Software installation media 

NEMS-A software installation package 
NEMS-A Instructions for Use 
Readme.txt 

Software key 

Compatible Applications 
The NEMS-A application is compatible with the following applications: 

• Norav PC-ECG (Rest, Stress, HRV, LP, and ECG "monitoring") 

• Norav Holter NH-301 

• Norav NM-700 Telemetry 

• Norav HMS 

• NSpiro™ 

• MIR Spiro 
 

Compatible Devices 
The NEMS-A application is compatible with the following Norav and 3rd party devices either directly or through 
relevant compatible applications: 

• Norav NR series devices, including NR-314-P 
• PC-ECG 1200 Series 

• NBP-24 NG 
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• NBP One 

• Oscar 2 

• NSpiro™ spirometry 

• MiniSpir spirometry 
 

Recommended PC Specifications 
Component NEMS-A Client 

CPU i5 @ 2.0 GHz 10th generation 

RAM 4 GB 

Free Disk Space 8 GB 

Operating System Windows 10 Pro 32/64 bit or Windows 11 Pro 

Free USB/LAN Ports 1 

Prerequisites .NET Framework v4.72 

Installed Drivers HMS ABPM device 
NBP One device 
Norav driver 
Sentinel driver 
Norav printer driver 

Additional Software (3rd parties) HMS ABPM 
SPIRO 
PDF Viewer 
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NEMS-A Installation 
The software package is compatible with the Windows 10/11 operating system. 

To install the NEMS-A application: 
 

1. Run NEMS-A Setup from the NEMS-A software installation package. The NEMS Setup Wizard dialog box will 
appear. 

Figure 2. NEMS-A Installation - NEMS Prerequisites Setup Wizard Dialog Box 
 

2. Click Next. The Prerequisites dialog box will be displayed. 
3. Select the prerequisite software you need to install. Select the MiniSpir Spirometer module checkbox to install 

the software application for using the MiniSpir spirometry device. If you do not need this functionality, clear the 
checkbox. Click Next to proceed. 
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Figure 3. NEMS-A Installation - Prerequisites 
 

4. You will be prompted with a pop-up window indicating the progress of the prerequisites installation. 
Once the prerequisites installation is complete, the NEMS Setup Wizard dialog box will appear. 

Figure 4. NEMS-A Installation - NEMS Setup Wizard Dialog Box 
 

5. Click Next. The Select Installation Folder dialog box will be displayed. 
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Figure 5. NEMS-A Installation - Select Installation Folder Dialog Box 
 

6. To install NEMS-A in the default location, click Next. 
7. (Optionally) To install NEMS-A in a different location: 

◦ Click the Folder text field and type in the new installation path manually. 

Figure 6. NEMS-A Installation - Selecting Installation Folder Manually 
◦ Click Browse and follow the sequence:: 

7.1. Navigate to the desired location. 
7.2. (Optionally) Create a folder to install NEMS-A in. 
7.3. Select the relevant folder. 
7.4. Click OK. 
7.5. Click Next. 
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8. The Ready to Install dialog box will appear. Click Install to launch the installation process. 

Figure 7. NEMS-A Installation - Ready to Install Dialog Box 
9. The Installing NEMS prompt box will appear. 

Figure 8. NEMS-A Installation - Installing NEMS Box 
10. During the installation process, you will be prompted with the Select Language dialog box to set the 

application language: 
10.1. Click the drop-down menu and choose the language you require. 
10.2. Click Save to confirm your selection and continue with the installation. 
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Figure 9. NEMS-A Installation - Select Language 

 
11. After the installation is complete, the Completing the NEMS Setup dialog box will appear. Click Finish to 

exit the Setup Wizard and complete the installation process. 

Figure 10. NEMS-A Installation - Completing the NEMS Setup dialog box 
 

12. After completing the installation, the NEMS-A application icon will appear on your PC desktop. 

Figure 11. NEMS-A Installation - NEMS-A Icon 
 

Additional <Back and Cancel buttons are available in the appropriate dialog boxes throughout the installation 
process. Click <Back to return to the previous dialog box. Click Cancel if you want to abort the installation process. 
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Figure 12. NEMS-A Installation - Cancel Installation 
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First Launch Set Up 
When you launch NEMS-A for the first time after installing it, you need to confirm or configure the 
NEMS-A database path: 
1. Click the NEMS-A icon on your computer desktop to start the application. 

2. You will be prompted with the Database Initialization dialog box. 
Figure 13. First Launch Set Up - Selecting Database 

 
3. If there is no existing database: 

3.1. Select the New Database option (if not already selected). 
Figure 14. First Launch Set Up - Selecting Database 

 
3.2. Click Next. The Create New Database dialog box will be displayed. 
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Figure 15. First Launch Set Up - Create New Database Dialog Box 
 

3.3. (Optionally) Click the New Database Name text field and modify the default database name manually. 
3.4. (Optionally) To modify the default New Database Location path: 

▪ Click the New Database Location text field and modify the default database location manually. 
▪ Click the Search icon to the right of the New Database Location text field. The Browse For Folder 

dialog box is displayed: 
Figure 16. First Launch Set Up - Selecting Folder 

 
3.4.1. Navigate to the location you need and choose a relevant folder. 
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Figure 17. First Launch Set Up - Browse For Folder 

 
3.4.2. (Optionally) To create a new folder, click Make New Folder in the bottom-left corner of 

the dialog box and type in the folder name manually. 
3.4.3. After you have selected the folder, click OK to confirm the new database location path. You 

will be redirected to the Create New Database dialog box. 
4. (Optionally) If there is a database on your PC you want to connect to the NEMS-A application: 

4.1. Select the Open Database option. 
Figure 18. First Launch Set Up - Open Database 

 
4.2. Click Next. The Open Database dialog box is displayed. 
4.3. (Optionally) To set or modify the path to the existing database you want to open: 
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Figure 19. First Launch Set Up - Open Database Dialog Box 
 

▪ Click the text field and type in the full path (including the data base file name) to the existing database 
you want to open. 

▪ Click the Search icon to the right of the text field. The Open File dialog box is displayed: 
Figure 20. First Launch Set Up - Open File Dialog Box 

 
 
 
 

5. Click Finish. 

4.3.1. Navigate to the location where the existing database file is stored. 
4.3.2. Select the database file (in .edb format). 
4.3.3. Click OK to open the database file. You will be redirected to the Open Database dialog box. 
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Figure 21. First Launch Set Up - Click Finish 
 

6. When the database configuration is complete, the NEMS-A application window will appear. 
Figure 22. First Launch Set Up - NEMS-A Window 

 
Additional <Back and Cancel buttons are available in the appropriate dialog boxes throughout the installation process. 
Click <Back to return to the previous dialog box. Click Cancel if you want to abort the installation process. 
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Interface Core Elements Overview 
In this chapter, we will provide an overview of the basic interface elements of the NEMS-A application. You will 
learn about the functionality of the following user interface (UI) elements: the top Menu Bar, the Main Toolbar, 
Records, Patients, Manage, and Devices tabs on the left; the Exit button; and the window control buttons. 

Figure 23. Interface Overview - NEMS-A Initial Screen 

Here, a detailed description of the basic interface elements is provided, along with guidance on how to use them. To enhance clarity, 
the elements in the figures are distinguished by color: 

• Actionable elements, such as buttons and menus, are marked in red. 
• Non-actionable elements, including informative elements or specific screen areas, are marked in green. 

Figure 24. Interface Overview - Menu Bar and Main Toolbar 
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Figure 25. Interface Overview - Tabs, Exit, View Area 
 
The elements depicted in figures above are consistently available across all screens and views 
within the NEMS-A app: 

1. Menu Bar: Contains menus and options that control functions such as record import, 
database initialization, setup menu, about the app feature, etc. 

2. Main Toolbar: Contains options for importing and setup, exit button, and about the app 
feature. 

3. Tabs: A designated sidebar that allows switching between different tabs available within the 
app - Records, Patients, Manage, Devices. These tabs enable managing test records, 
patients, patients' data, medical personnel lists, and device scanning. 

4. Exit button: Click this button to close the application. 
5. View Area: In contrast to other interface elements that stay mostly the same on every 

screen, this area contains unique content, data, and controls within each application tab. 
6. Window Control Buttons: Features a standard set of controls for window states. 

 
Please refer to the relevant sections in this Chapter for detailed descriptions of each element. 
  



D/N: NV-400.2790.050|Rev02 NEMS-A Instructions for Use Page 27 of 166 
 

Menu Bar 
The Menu Bar contains menus and options that manage general functions of the NEMS-A, 
such as importing records, database initialization, setup menu, and the about feature. A 
detailed description of the Menu Bar components can be found below. 

Figure 26. Interface Overview - Menu Bar 
 

The Menu Bar includes three drop-down menus: 
• File 
• View 
• Help 

 
File Menu 
The File menu contains the following options: 

Figure 27. Interface Overview - File Menu 
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Icon Description 

 

Import: Click to import a record file supported by NEMS-A. 

 

Import Directory: Click to import a folder with record files supported by NEMS-A. 

 

Initialization Wizard: Click to set up a path to the NEMS-A database. 

 

Exit: Click to exit NEMS-A and close the application. 

To import a record file: 
1. Click the File menu in the Menu Bar to expand it. 
Figure 28. Interface Overview - File Menu 

2. Click Import to open the Import File dialog box. 
Figure 29. File Menu - Import Option 

3. Navigate to the location with the files supported by NEMS-A that you want to 
import. 
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Figure 30. File Menu - Import File Dialog Box 

 
4. Select the file(s) you want to import: 

◦ Click an individual file to select it. 
◦ Select several files using one of these methods: 

▪ Using Click-and-Drag: 
4.1. Click any empty space in the Windows Explorer window, hold 

down the left mouse button, and drag your cursor over the files you 
want to select. This will create a selection box. 

4.2. Ensure that all files you wish to select are within the boundaries of 
this selection box. 
4.3. Release the mouse button to complete the selection. 

▪ Using Ctrl + Click: 
4.1. Click on the first file you want to select. 
4.2. Hold down the Ctrl key. 
4.3. While holding the Ctrl key, click on each additional file you want 

to select. Each clicked file will be added to your selection. 
▪ Using Shift + Click: 

4.1. Click on the first file in a series of files you want to select. 
4.2. Hold down the Shift key. 
4.3. Click on the last file. All files between the first and last file you 
clicked will be selected. 

▪ If you want to select all files in the given folder, click Ctrl + A. 
5. Click Open in the bottom-right corner to import the file(s). 
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Figure 31. File Menu - Importing Files 

 
6. You will be prompted with the Results dialog box showing the process and 

outcomes of the importing. After the importing is complete, you will see the 
information on the following: 

Figure 32. File Menu - Results Dialog Box 
 

◦ Files to import: The overall number of files you have selected for the 
import. 
◦ Imported files: The number of files that were imported (no errors 
occurred). 
◦ Total errors: The number of files that were not imported due to errors. 
◦ Files with wrong data: The number of files that were validated as 
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records with incorrect data. 
7. Click OK to close the Results dialog box and finish the import, or click Cancel 
to abort. 

 
To import a directory: 

 
1. Click the File menu in the Menu Bar to expand it. 
2. Click Import Directory to open the Browse for Folder dialog box. 
3. Navigate to the location with the folder containing files supported by NEMS-A 
that you want to import. 
4. In the Browse for Folder dialog box, select the folder you want to import. You 
can select only one folder. 
5. Click OK. 
6. You will be prompted with the Results dialog box showing the process and 
outcomes of the importing. After the importing is complete you will see the 
information on the following: 

◦ Files to import: The overall number of files you have selected for the 
import. 

◦ Imported files: The number of files that were imported (no errors 
occurred). 

◦ Total errors: The number of files that were not imported due to errors. 
◦ Files with wrong data: The number of files that were validated as 

records with incorrect data. 
7. Click OK to close the Results dialog box and finish the import, or click Cancel 
to abort. 

 
To setup a path to the NEMS-A database: 

 
1. Click the File menu in the Menu Bar to expand it. 

Figure 33. File Menu - Initialization Wizard 

 
1.1. Click Initialization Wizard in the File menu. The Database Initialization dialog 

box will be displayed. 

Note: If you already have an existing NEMS-A database, connecting a new database will make all the records contained in the existing 
database unavailable. 
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Figure 34. File Menu - Selecting Database 

 
1.2. If there is no existing database: 

1.2.1. Select the New Database option (if not already selected). 
Figure 35. First Launch Set Up - Selecting Database 

 
1.2.2.Click Next. The Create New Database dialog box will be displayed. 
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Figure 36. First Launch Set Up - Create New Database Dialog Box 
 

1.2.3. (Optionally) Click the New Database Name text field and modify the default 
database name manually. 

1.2.4. (Optionally) To modify the default New Database Location path: 
▪ Click the New Database Location text field and modify the default database 

location manually. 
▪ Click the Search icon to the right of the New Database Location text field. 

The Browse For Folder dialog box is displayed: 
Figure 37. First Launch Set Up - Selecting Folder 

 
1.2.4.1. Navigate to the location you need and choose a relevant folder. 
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Figure 38. First Launch Set Up - Browse For Folder 

 
1.2.4.2. (Optionally) To create a new folder, click Make New Folder in the 

bottom-left corner of the dialog box and type in the folder name 
manually. 

1.2.4.3. After you have selected the folder, click OK to confirm the new 
database location path. You will be redirected to the Create New 
Database dialog box. 

1.3. (Optionally) If there is a database on your PC you want to connect to the NEMS-A 
application: 

1.3.1. Select the Open Database option. 
Figure 39. First Launch Set Up - Open Database 

 
1.3.2. Click Next. The Open Database dialog box is displayed. 
1.3.3. (Optionally) To set or modify the path to the existing database you want to 

open: 
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Figure 40. First Launch Set Up - Open Database Dialog Box 
▪ Click the text field and type in the full path (including the data base file name) to 

the existing database you want to open. 
▪ Click the Search icon to the right of the text field. The Open File dialog box is 

displayed: 
Figure 41. First Launch Set Up - Open File Dialog Box 

 
1.3.3.1. Navigate to the location where the existing database file is stored. 
1.3.3.2. Select the database file (in .edb format). 
1.3.3.3. Click OK to open the database file. You will be redirected to the 

Open Database dialog box. 
1.4. Click Finish. 
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Figure 42. First Launch Set Up - Click Finish 

Additional <Back and Cancel buttons are available in the appropriate dialog boxes 
throughout the installation process. Click <Back to return to the previous dialog box. Click 
Cancel if you want to abort the installation process. 

 
View Menu 
The View menu contains the following options: 

Figure 43. Interface Overview - View Menu 

 
Icon Description 

 Toolbar: Click to toggle ON/OFF the Main Toolbar beneath the Menu Bar. 
Please refer to the Main Toolbar section for more details. 
 Setup: Click to open the NEMS-A Setup dialog box containing multiple tabs with 
the application's general settings. Please refer to the Setup subsection for more 
details. 

 
Help Menu 
The Help menu contains the following options: 

Figure 44. Interface Overview - Help Menu 

 
About: Click to view the About page, which contains the information on version of 
the NEMS-A installed on your PC and Norav Software Permissions. Permissions 
represent the list of permissions enabled by the specific license key you are using at the 
moment. Different permission types encoded with M1, H1, NM700, and similar codes 
are related to various Norav Software applications interconnected with the NEMS-A 
app. 
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Figure 45. Interface Overview - View Menu - About 
To close the About page, click OK in the bottom-right corner. 

 

Note: You do not need any license keys to perform Blood Pressure (ABPM) tests using NEMS-A. 
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Main Toolbar 
The Main Toolbar provides quick access to the most commonly used features also found 
within menus in the Menu Bar, such as importing records, setup menu, about the app 
feature, etc. A detailed description of the components can be found below. 

Figure 46. Interface Overview - Main Toolbar 

 
The Main Toolbar includes four icons, representing the following features: 

• Import 
• Setup 
• Exit 
• About 

 
Icon Description 

 

Import: Click to import a record file supported by NEMS-A. 

 

Setup: Click to open the NEMS-A Setup dialog box containing multiple tabs with 
application general settings. Please refer to the Setup subsection) for more details. 

 

Exit: Click to exit NEMS-A and close the application. 

 

About Click to view the About page containing the version of the NEMS-A installed on 
your PC and Norav Software Per­ missions. Permissions represent the list of permissions 
enabled by the specific license key you are using at the moment. 
Different permission types encoded with M1, H1, NM700, and similar codes are related to 
different Norav Software applications interconnected with the NEMS-A app. 
To close the About page, click OK in the bottom-right corner. 

 
To import a record file: 

 
1. Click the Import icon in the Main Toolbar to open the Import File dialog box. 
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Figure 47. Toolbar - Clicking Import 

 
2. Navigate to the location with the files supported by NEMS-A that you want to import. 

Figure 48. File Menu - Import File Dialog Box 

 
3. Select the file(s) you want to import: 

◦ Click an individual file to select it. 
◦ Select several files using one of these methods: 

▪ Using Click-and-Drag: 
3.1. Click any empty space in the Windows Explorer window, hold down the 

left mouse button, and drag your cursor over the files you want to select. 
This will create a selection box. 

3.2. Ensure that all files you wish to select are within the boundaries of this 
selection box. 

3.3. Release the mouse button to complete the selection. 
▪ Using Ctrl + Click: 

3.1. Click on the first file you want to select. 
3.2. Hold down the Ctrl key. 
3.3. While holding the Ctrl key, click on each additional file you want to select. 

Each clicked file will be added to your selection. 
▪ Using Shift + Click: 

3.1. Click on the first file in a series of files you want to select. 
3.2. Hold down the Shift key. 
3.3. Click on the last file. All files between the first and last file you clicked will 

be selected. 
▪ If you want to select all files in the given folder, click Ctrl + A. 

4. Click Open in the bottom-right corner to import the file(s). 
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Figure 49. File Menu - Importing Files 

 
5. You will be prompted with the Results dialog box showing the process and outcomes of 

the importing. After the importing is complete, you will see the information on the 
following: 

Figure 50. File Menu - Results Dialog Box 
 

◦ Files to import: The overall number of files you have selected for the 
import. 
◦ Imported files: The number of files that were imported (no errors 
occurred). 
◦ Total errors: The number of files that were not imported due to errors. 
◦ Files with wrong data: The number of files that were validated as 
records with incorrect data. 

6. Click OK to close the Results dialog box and finish the import, or click Cancel to abort. 
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NEMS-A supports the import of different types of test files. 
 

File Type Description 
.bp Oscar 2 Blood Pressure test file 
.nbp NBP One Blood Pressure test file 
.bp2 NBP-24 NG Blood Pressure test file 
.pdf PDF file 
.rst Rest test file 
.str Stress test file 
.hlt Holter test file (NH-301 v.3.0.0 app) 
.hl4 Holter test analyzed file (NH-301 v.3.0.0 app) 
.hl5 Holter test analyzed file (NH-301 v.4.0.0 app and later) 
.nrr Holter test source file 
.res Holter source file 
.mnt Monitoring ECG test file 
.lp Late Potential test file 
.hrv Heart Rate Variability test file 
.mnr Telemetry File 
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Tabs 
The Tabs are functional application screens with a designated View Area, enabling users to 
manage or perform certain actions with test records, patients, patient groups, medical 
personnel lists, and compatible devices. Each Tab focuses on one primary entity, such as 
test records or patient entries and provides a comprehensive set of tools to process them. 

Figure 51. Tabs - Tabs Panel 

 
The NEMS-A application displays the following tabs in the tabs panel on the left: 
▪ Records 
▪ Patients 
▪ Manage 
▪ Devices 

 
Icon Description 
 

 

Records Tab: Click to navigate to this tab, enabling test records 
management, including viewing, reviewing, exporting, searching, sorting, 
etc. 

 

 

Patients Tab: Click to navigate to this tab, enabling patient management, 
includ ing adding new patients, editing, and deleting existing ones, 
preparing various devices to perform tests, etc. 

 

 

Manage Tab: Click to navigate to this tab, enabling the creation of user 
groups, as well as referring physicians, technicians, and reporting MDs 
lists. 

 

 

Devices Tab: Click to navigate to this tab, enabling the downloading of 
test records from Holter and ABPM devices (ECG and Blood Pressure 
recordings re­ spectively). 
 
Note: You can connect only one device at a time to download a record. 
To prevent potential downloading errors, avoid connecting multiple de­ 
vices during the records downloading step. 

Note: When you navigate to the Records or Patients tab just after launching the application, you will notice that the View Area of 
those tabs lacks records or patient data, respectively. To populate it with records/patient data, choose any search criteria and click 
Search. It is recommended to check all three checkboxes for the Gender option (applicable to both the Records and the Patients 
tabs) and the All option under the Test Date (applicable to the Records tab only) to display all available data. 
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Figure 52. Tabs - Records Tab Empty 

Figure 53. Tabs - Records Tab Interface 
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Figure 54. Tabs - Patients Tab Interface 
 

Figure 55. Tabs - Manage Tab Interface 
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Figure 56. Tabs - Devices Tab Interface 
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Window Control Buttons & Exit Button 
The Window Control Buttons element includes the window's Minimize, 
Restore/Maximize, and Close buttons, and is located in the top right corner of the 
window. The Exit button is located in the left-bottom corner. These buttons enable you to 
customize the app window size according to your preferences, change the window mode, or 
close the program. 

Figure 57. Interface Elements Overview - Window Control Buttons and Exit Button 

 
Minimize 
Click this button to minimize the window to an icon on the taskbar. The window is still 
running in the background, but it is not visible. 

Figure 58. Window Control Buttons - Minimize 

 
To restore the window, click on the program's icon on the Windows taskbar. 
 
Restore/Maximize 
Click this button to toggle between the maximized and restored states of a window. The 
maximized state is when a window fills the entire screen, and it cannot be resized or moved, 
though you can still see a title bar of the current window. 

Figure 59. Window Control Buttons - Restore or Maximize 
 

The restored size of the window is the size you set by dragging the edges of the window with 
the mouse cursor. The restored state of the window is an in-between state, when the window 
is neither minimized nor maximized. You can freely resize and move the window in a 
restored state. 

 
Close 
Click this button to close the window and exit the application. 

Figure 60. Window Control Buttons - Close 

 
Exit Button 
Click this button to close the window and exit the application. This button is similar to the 
Close button described above. 
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Figure 61. Window Control Buttons - Exit Button 
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NEMS-A Setup Feature Overview 
The Setup feature allows you to customize general application settings to suit your needs 
and workflows. The Setup dialog box consists of four tabs: Workspace, View, GDT, and 
ABPM Report. Within these tabs, you can manage and modify various settings, including 
the paths to the application's database and related test apps, the layout of tabs, the settings 
for data transfer format (GDT), and the layout of the blood pressure report. By adjusting 
these settings, you can change how the application interacts with specific test apps and 
performs related tests. 

Figure 62. Setup - Setup Dialog Box 
 

To access the Setup dialog box, do one of the following: 

• Click the Setup icon in the Main Toolbar. 
Figure 63. Setup - Main Toolbar Setup Option 

• Click the View menu in the Menu Bar in the top-left corner, then click Setup. 



D/N: NV-400.2790.050|Rev02 NEMS-A Instructions for Use Page 49 of 166 
 

Figure 64. Setup - View Menu Setup Option 

 
After doing that, you will be prompted with the Setup dialog box containing the following 

tabs: 
• Workspace 
• View 
• GDT 
• ABPM Report 

Figure 65. Setup - Setup Dialog Box 
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Workspace Tab 
The Workspace tab contains paths to various application assets: 

• Application database 
• External patient data file 
• Applications that perform relevant tests. The test data can be acquired, stored, and 

processed in the NEMS-A application after the test is successfully complete. 
 

Setup Option Description 

Database Name Contains the full path to the application's database, including the name of the .db 
database file. Here, you can modify the path to the database file, or load other 
database files, if needed. 
The same parameter is stored in the Settings.xml file on your PC in the following 
path: C:\ProgramData\NoravMedical\NEMS.  

Path Contains the full path to the default app folder. This folder contains test and report 
files, as well as the database file. You can't modify this field within the Setup dialog 
box. 

External Patient 
Data file 

Contains the full path to the PatientFile.ini file with the list of external patients. It 
houses common patient data. Using this file, a user can import external patient data to 
the NEMS-A (by creating a new patient entity or editing an existing one) to perform 
relevant tests. Here, you can modify the path to the external patient file, or load 
another file, if needed. 

ABPM NBP-
24NG 

Contains the full path to the .exe file of the standalone Norav ABPM application. The 
modern NEMS-A application embeds all ABPM capabilities, but a standalone ABPM 
application can be added using a full path. This is beneficial for users already utilizing 
the Norav ABPM NBP-24NG application with existing settings and patient lists, or 
for new users who prefer to maintain all data within the ABPM app. Here, you can 
modify the path to the desired application. 

Spirometer You can add a full path to the .exe file of the compatible Spirometer application. After 
adding the path, you will be able to initiate spirometer tests directly from the NEMS-A 
app. You can also modify the path to the relevant application, using this option. 

 
The method for changing the path for any of the options listed above follows a single logic 
and sequence. In the example below, we will open (load) a new External Patient Data file: 

1. Click the Search icon to the right of the text box. The Open File dialog box is 
displayed. 

2. Navigate to the location where the file you want to load (open) is stored. 
3. Select the file (an .ini file in this case). 
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Figure 66. Setup - Opening File 

 
4. Click Open to open the file. You will be redirected to the Setup dialog box. You will 

see a new path in the relevant text box. 
Figure 67. Setup - Applying Changes 
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5. Click OK in the bottom part of the Setup dialog box to apply the changes. 

 

Figure 68. Setup - Adding External Patients 
 

Note: After opening a new External Patient Data File, the process to import new patient data involves specific steps: 

1. Click on the Patients tab. 
2. Select New > External (or Edit > External). 
3. Choose the desired patient in a dialog box. 
4. Click Select. 
5. Click OK. 
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View Tab 
The View tab comprises three sub-tabs, each with specific setting parameters: 

• General 
• Records 
• Patients 

Figure 69. Setup - View Tab 
 

General 
The General tab offers the Main Toolbar option, allowing toggling the Main Toolbar 
element of the NEMS-A application ON or OFF. 
 
To toggle the Main Toolbar ON or OFF: 

1. Click the Setup option in the Main Toolbar or in the View menu of the Menu Bar. 
2. Click the View tab. 

Figure 70. Setup - View Tab Toolbar Option 

3. Click the checkbox beside the Main Toolbar option. 
4. Click OK at the bottom of the dialog box. 
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5. Restart the application to apply the changes. 
 

Repeat this sequence whenever you need to switch the Main Toolbar ON or OFF. 
 
 
Records 
The Records tab enables users to customize the layout of the Records screen. It offers a 
flexible interface for selecting and organizing fields related to records. This feature allows 
users to arrange columns in their preferred order, including fields like Patient ID, First 
Name, Last Name, Test Date, and others. Additionally, it allows users to adjust the 
visualization of ECG example strips associated with Rest-type records. 

Figure 71. Setup - View Tab - Records Tab 
 
Under the Define Fields option, you can configure common patient data fields for each patient 
record and the sequence of their appearance for each entry in the Records tab. 
 
To select which columns to display in the Records tab and arrange the layout: 
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1. Click on the Records option under the Define Fields option. This will open the 
Column Selection dialog box. 

Figure 72. Setup - View Tab - Clicking Records 
 

2. (Optional) To toggle any of the 25 available columns ON/OFF, excluding the Type 
column: 

◦ Click a checkbox next to the relevant column name (e.g., Patient ID, First Name, 
Test Date) to toggle it ON or OFF. 

◦ Select a column to toggle ON/OFF and click the Show or Hide button on the 
right to display or hide this column. 

3. (Optional) To move a column forward (up in the list) or backward (down in the list) in 
the records list: 

◦ Select a column to move and click Move Up on the right to shift it one position 
up in the dialog box and forward in the records list. This action can be repeated 
multiple times. 

◦ Select a column to move and click Move Down to shift it one position down in 
the dialog box and backward in the records list. This action can be repeated 
multiple times. 

4. Click OK to save the changes. 
5. Click OK to apply the changes. 

 
The Column Selection dialog box, located in the Records tab, provides a selection of 25 
columns that can be displayed and arranged according to your preferences. 

 
Column Name Description 
Type Type of the test. 
Patient ID Patient ID stored in the system. 
MRN Medical Record Number: A unique identifier for each patient's 

medical record. 
First Name Patient's First Name. 
Last Name Patient's Last Name. 

Note: The Type column cannot be turned off as it contains data about the test type. You can only change the position of this column 
using the Move Up and Move Down buttons in the Column Selection dialog box. 
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Gender Patient's Gender. 
Birth Date Patient's Birth Date. 
Test Date The date on which the test was performed and the record was created. 
Site Location where the test was conducted (e.g., medical facility name). 
Referring MD The physician who requested the test. 
Referring Dept The department or clinic issuing the test order. 
Priority Indicates the urgency of the test and interpretation. 
Supervising MD The physician overseeing the reporting MD's work. 
Reporting MD The physician analyzing the ECG data and providing a report. 
Technician The healthcare professional performing the ECG test. 
Order Test identification number (data). 
Duration Duration of the test. 
Analysis Center The laboratory or department analyzing test data and generating a 

report. 
Analyzing 
Technician 

The technician reviewing and analyzing ECG data. 

Category Classifies the test category. 
Estimated 
Duration 

Estimated duration of the test. 

Exported Green checkmark indicating record export. 
Printed Green checkmark indicating record printing. 
Reported Green checkmark indicating report generation. 
Visit Number Unique identifier for each patient visit. 
Uploaded Not in use in this version of the app (turned OFF by default). 

 
Under the Show ECGs option, you can customize how ECG waveforms are shown for 
Rest ECG records and choose whether to include ABPM test example strips with a patient's 
record. 

 
To display example strips in the Rest ECGs and ABPM records: 

1. Check the Show ECGs checkbox. 
2. Click OK to save the changes. 

 
In the ECG Color Selection section, you can click on the available options to change the 
color scheme of the ECG example strips using the generic color box. 
 
In the Strip Lead section, located right below the ECG Color Selection section, you can 
choose a specific ECG channel to display in the aforementioned ECG example strips 
associated with patients' records. 

 
To select or change the displayed ECG channel: 

1. Click the radio button next to the channel you want to display. 
2. Click OK to save the changes. 
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Patients 
The Patients tab enables users to modify the layout of the Patients screen, which includes 
the Tests view at the bottom. This functionality allows users to tailor patient-related 
information to suit their individual requirements and work processes. Users can organize 
columns in the Patients screen in the sequence they prefer. 
Within the Define Fields option, users can set up the standard data fields for patients in the 
Patients view and specify their display order. Users can also set up the data fields for the 
Tests view. 
 
To select which columns to display in the Patients view and arrange the layout, follow these 
steps: 

1. Click on Patients under the Define Fields option. This will open the Column 
Selection dialog box. 

Figure 73. Setup - View Tab - Patients - Patients Dialog Box 

 
2. (Optional) To toggle any of the available columns ON/OFF, excluding the Patient 

ID column: 

 
◦ Click a checkbox next to the relevant column name (e.g., Patient ID, First Name, 

Weight) to toggle it ON or OFF. 
◦ Select a column to toggle ON/OFF and click the Show or Hide button on the 

right to display or hide this column. 
3. (Optional) To move a column forward (up in the list) or backward (down in the list) in 

the patients list: 
◦ Select a column to move and click Move Up on the right to shift it one position 

up in the dialog box and forward in the patients list. This action can be repeated 
multiple times. 

Note: The Patient ID is the main patient's identification and tracking parameter, so the column cannot be turned OFF. You 
can only change the position of this column using the Move Up and Move Down buttons in the Column Selection dialog box. 
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◦ Select a column to move and click Move Down to shift it one position down in 
the dialog box and backward in the patients list. This action can be repeated 
multiple times. 

4. Click OK to save the changes. 
5. Click OK to apply the changes. 

 
The Column Selection dialog box of the Patients view offers a number of columns similar 
to those you can find in the Column Selection dialog box of the Records tab. Below, you can 
find a list of unique columns associated with the Patients view. 

 
Column Name Description 

Weight Patient's weight. 
Height Patient's height. 
Group A designated group that can be assigned to a specific patient. Users can create groups 

and add patients to effectively manage them. 
Phone 1 Patient's primary phone number. 
Phone 2 An alternative phone number for the patient, such as a work or mobile number. 
Fax Patient's fax number, if applicable. 
E-mail Patient's email address. 
Address Patient's mailing address. 
Medications Information about the patient's current medications. 
Other This field can be used to store any additional patient-related information not covered 

by other fields. Examples might include emergency contact information, preferred 
language, allergies, or insurance provider details. 

Indications Reason(s) for the patient's visit or referral. 
 

To select which columns to display in the Tests view and arrange the layout: 
1. Click Tests under the Define Fields option. The Column Selection dialog box will 

appear. 

Figure 74. Setup - View Tab - Patients - Tests Dialog Box 
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2. (Optional) To toggle any of the available columns ON/OFF, excluding the Type 
column: 

 
◦ Click a checkbox next to the relevant column name (e.g., Patient ID, First Name, 

Weight) to toggle it ON or OFF. 
◦ Select a column to toggle ON/OFF and click the Show or Hide button on the 

right to display or hide this column. 
3. (Optional) To move a column forward (up in the list) or backward (down in the list) in 

the patients list: 
◦ Select a column to move and click Move Up on the right to shift it one position 

up in the dialog box and forward in the patients list. This action can be repeated 
multiple times. 

◦ Select a column to move and click Move Down to shift it one position down in 
the dialog box and backward in the patients list. This action can be repeated 
multiple times. 

4. Click OK to save the changes. 
5. Click OK to apply the changes. 

 
Column Name Description 
Type Type of the test. 
Test Date The date on which the test was performed and the record was created. 
Technician The healthcare professional performing the ECG test. 
Referring MD The physician who ordered the test. 
Referring Dept The department or clinic issuing the test order. 
Site Location where the test was conducted (e.g., medical facility name). 
Category Classifies the test category. 
Reported Green checkmark indicating report generation. 
Reporting MD The physician analyzing the ECG data and providing a report. 
Rep. # Report number. 
Report Date The date when the report was generated. 
Printed Green checkmark indicating record printing. 
Exported Green checkmark indicating record export. 
Uploaded Not in use in this version of the app (turned OFF by default). 
Order Test identification number (data). 
Duration Duration of the test. 
Estimated 
Duration 

Estimated duration of the test. 

Analysis Center The laboratory or department analyzing test data and generating a report. 
Analyzing 
Technician 

The technician reviewing and analyzing ECG data. 

Visit Number Unique identifier for each patient visit. 
 

Note: The Type column cannot be turned off as it contains data about the test type. You can only change the position of this 
column using the Move Up and Move Down buttons in the Column Selection dialog box. 
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GDT Tab 
GDT is a communication protocol between the entity that orders the test and NEMS-A, 
which transfers the test results file generated by NEMS-A. The entity that orders the test 
places a file containing patient details and test type in a specific location. NEMS-A reads this 
file and displays the information onscreen. The user then performs the test. After the test is 
complete, the test results file is created and sent to the entity that ordered the test. The GDT 
tab includes the following options: 

Figure 75. Setup - GDT Tab 
 

Option Description 
Enable GDT 
Import 

Click the checkbox to turn ON/OFF GDT files import. Checked by default. 

Input file Token A prefix consisting of four characters in the filename to indicate that this GDT file 
is an inbound file either generated by EMR or placed into the inbound folder 
manually. By default, the value of this option is set to: NEMS. 

Input folder A path to the folder for GDT files to be imported into NEMS-A. By default, the 
value of this option is set to: C:\ProgramData\NoravMedical\NEMS\GDT 

Code page Select a character encoding standard (code page) relevant to your PC's country and 
language settings. 

Enable GDT 
Export 

Click the checkbox to turn ON/OFF GDT reports export from NEMS-A to the 
dedicated folder or EMR (NBP-24 NG reports only). Checked by default. 

Output file 
Token 

A prefix consisting of four characters in the filename to indicate that this GDT 
report file is generated by NEMS-A. By default, the value of this option is set to: 
EDV1. 

Output folder A path to the output folder for placing GDT report files generated by NEMS-A. 
By default, the value of this option is set to: 
C:\ProgramData\NoravMedical\NEMS\GDT 
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To change the Input file Token or Output file Token option value: 

1. Click a relevant text field. 
2. Adjust the existing token or type in a new token (prefix) manually. 
3. Click OK to apply the changes. 

Figure 76. Setup - GDT Tab - Input and Output File Tokens 
 

To change the Code page: 
1. Click the Code page drop-down menu to unfold it. 
2. Select the code page you need. 
3. Click OK to apply the changes. 

Figure 77. Setup - GDT Tab - Input and Output Folders 
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To change the Input folder or Output folder path: 

1. Click the Search icon. The Browse For Folder dialog box will be displayed. 
2. Navigate to the relevant folder or click Make New Folder to create a new one. 
3. Select the desired folder. 
4. Click OK to apply the changes. 
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ABPM Report Tab 
The ABPM Report tab contains options enabling layout adjustments for this specific type 

of reports in NEMS-A: 
• Date Format 
• Header Alignment 

 
Date Format 
The Date Format option determines how the date and time will be presented in the ABPM 
test record. It offers a set of date and time formats to choose from, as shown below. 

Figure 78. Setup - ABPM Report Tab - System Default Settings 
 

System default date and time formats are: 
• Date: MM/DD/YYYY 
• Time: 12h 

 
To adjust the Date or Time format: 

1. Click the Custom radio button under the Date Format option to unlock the Date and 
Time radio buttons. 
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Figure 79. Setup - ABPM Report Tab - Custom Date and Time 

2. Click on the relevant radio button: 
◦ Under the Date option: To select the desired Date format. 
◦ Under the Time option: To select the desired Time format. 

3. Click OK to apply the changes. 
 

Header Alignment 
The Header Alignment option determines how the report header will align in the ABPM 
test record. It provides three standard choices: Left, Center, and Right. By default, Header 
Alignment is set to Left. 
 
To adjust the Header Alignment: 

1. Click on the appropriate radio button within the Header Alignment section. 
Figure 80. Setup - ABPM Report Tab - Header Alignment 

2. Click on OK to apply the changes. 
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Local Configuration File 
Some parameters are adjustable in the local Settings.xml configuration file located in 
C:\ProgramData\NoravMedical\NEMS folder. 

 

Config. Tag Name Description 

<InboxFileDirectory> Inbound folder for automatic data import 

<OutboxFileDirectory> Outbound folder for automatic PDF reports export 

<SQL_ACCESS> Database mode. The value is always 0 for NEMS-A system 

<StressPdfFolder> PC-ECG software main folder path in Program Files 

<NBP_database> NHMS system database file name (for H2 Client database mode only) 

<NSpiro_GDT> GDT exchange folder path for the spirometry program 
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App Operation Overview 
In this Section, an overview of the main operational functions of the NEMS-A app is 
provided through detailed description of the application's tabs capabilities. The Tabs are 
functional application screens with a designated View Area, enabling users to manage or 
perform certain actions with test records, patients, patient groups, medical personnel lists, 
and compatible devices. Each Tab focuses on one primary entity, such as test records or 
patient entries and provides a comprehensive set of tools to process them. 
 

Figure 81. Tabs - Tabs Panel 

 
The NEMS-A application displays the following tabs in the tabs panel on the left: 

• Records 
• Patients 
• Manage 
• Devices 

 
Icon Description 

 

Records Tab: Click to navigate to this tab, enabling test records 
management, including viewing, reviewing, exporting, searching, sorting, etc. 

 

Patients Tab: Click to navigate to this tab, enabling patient management, 
including adding new patients, editing, and deleting existing ones, preparing 
various devices to perform tests, etc. 

 

Manage Tab: Click to navigate to this tab, enabling the creation of user 
groups, as well as referring physicians, technicians, and reporting MDs lists. 

 

Devices Tab: Click to navigate to this tab, enabling the downloading of test 
records from Holter and ABPM devices (ECG and Blood Pressure 
recordings respectively). 
 
Note: You can connect only one device at a time to download a record. To 
prevent potential downloading errors, avoid connecting multiple de­ vices 
during the records downloading step. 
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Figure 82. Tabs - Records Tab Empty 
 

Note: When you navigate to the Records or Patients tab just after launching the application, you will notice that the View Area of 
those tabs lacks records or patient data, respectively. To populate it with records/patient data, choose any search criteria and click 
Search. It is recommended to check all three checkboxes for the Gender option (applicable to both the Records and the Patients 
tabs) and the All option under the Test Date (applicable to the Records tab only) to display all available data. 
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Records Tab 
The Records tab facilitates the following capabilities: 

• Searching records by applying different types of search filters. 
• Searching records by scanning a barcode. 
• Operations on records – including viewing, exporting, reviewing, deleting, and more. 

 
The Records tab includes the following sections: 

1. Filters Pane 
2. Actions Bar 
3. Records List 
4. Preview Panel 

Figure 83. Records Tab - Tab Sections 
 

It allows users to display records using various filters in the Filters Pane and perform 
operations on patients' records in the Records List. 

 

Filters Pane 
The Filters Pane offers various filters to help users efficiently search for records based on 
key parameters such as test type, test date, patient ID, and more. Refer to the table below for 
a detailed description. 

Figure 84. Records Tab - Filters Pane 

 
To filter the records: 

1. Select available options and/or enter relevant values in the appropriate text fields. 
2. Click the Search button to apply filters. 
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Figure 85. Records Tab - Filters Pane - Warning Sign 
 
Filter Types 

Filter Description 
Type Filter by Test Type: Click on the Type drop-down menu and select (check) checkboxes 

next to relevant test types (you can use multiple selection): Rest, Stress, Holter, ABPM, 
or SPIRO. 

Site Filter by Test Site: Click on the Site drop-down menu and select the checkboxes next 
to the relevant test sites. A site can be a clinic or a specific location, e.g., Delray Clinic, 
RAMBAM Hospital, etc. The specific sites are derived from the "Site" parameter of the 
records populating the Records List. 

Test Date Filter by Test Date: Click the relevant radio button to choose an appropriate test date 
range: All, Today, Last Week, Last Month, or From/To. When selecting the 
From/To option, enter the relevant dates in the text fields next to this option. 

Patient ID Filter by Patient ID: Enter the patient's ID in the text field next to this option. 
MRN Filter by Medical Record Number: Enter the MRN in the text field next to this 

option. 
Last Name Filter by Last Name: Enter the patient's last name in the text field next to this option. 
First Name Filter by First Name: Enter the patient's first name in the text field next to this option. 
Group Filter by Group: Click on the Group drop-down menu and select a patient group to 

filter the records. Patient groups can be created in the Manage tab. After creating a 
Group, you can add patients to it and search for them in the Records tab using this 
filter. You need to create relevant groups first to use them for filtering records. There is 
only one predefined default patient group named All, which includes all patients within 
the system. For more detailed information about groups, refer to the Manage section. 

Gender Filter by Gender: To filter the records, select the checkboxes next to the gender 
markers: M (Male), F (Fe­ male), Undefined. You can make multiple selections. 

 

Actions Bar 
The Actions Bar embeds a list of actions a user can perform on records within the Records 
tab, including viewing, exporting, reviewing, and more. Refer to the table below for a 
detailed description. 

Figure 86. Records Tab - Actions Bar 

 
 
 

Note: You need to select or enter at least one search parameter (excluding the default value "All" under Test Date) to display 
records in the Records List. Until you choose a search parameter, a warning sign appears beneath the Search button (as shown 
below). 
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Button Description 
Print Click this button to print the report associated with the selected record. You need a 

PDF viewer installed on your PC to print the report. 
Export Click this button to export the report associated with the selected ABPM, Rest, or Stress 

record (not available for Holter records). If the report does not exist, it will be created 
and exported to the [YOUR_DRIVE]:\Program- 
Data\NoravMedical\NEMS\ECGDBase\Reports folder. Once exported, the record 
will be marked with a green check­ mark in the Exported and Reported columns of the 
Records List. 

Copy Click this button to copy the selected record to a backup. This operation allows you to 
duplicate a record for backup purposes, review by another physician without access to 
the NEMS-A system, or transfer to another location. 

Move Click this button to move the selected record. The Move operation is intended to 
transfer an existing record to an external location and remove it from the NEMS-A 
system. This operation can be used for moving an incorrect test or migrating a record 
from one system to another. Once moved, the record can no longer be viewed within 
NEMS-A. Only an indication of the record remains within the system, if needed. 

Delete Click this button to delete the selected record. 

Reassign Click this button to reassign the selected record to another patient. Reassigning a record 
is necessary if it was mistakenly assigned to the wrong patient. 

Review Click this button or double-click a record in the Records List to review the selected 
record within the rel­ evant application. For example, Rest and Stress records are 
reviewed in PC-ECG 1200, Holter records in NH-301, and ABPM records directly 
within the NEMS-A app. This action facilitates test review and report 
generation. Once reviewed, the record will be marked with a green checkmark in the 
Reported and Export­ ed columns of the Records List. 

View Report Click this button to view the report associated with the selected record. If the report 
does not exist, it will be generated, and the PDF containing the report will open in the 
available PDF viewer. 

 
Exporting Reports 
 
To export a report: 

Figure 87. Records Tab - Actions Bar - Export 

1. Select a record in the Records List. 
2. Click the Export button in the Actions Bar. 
3. A progress indicator pop-up will be displayed: 
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Figure 88. Records Tab - Export - Progress Indicator 

 
◦ If a report is associated with the selected record, the progress indicator pop-up 

will disappear after a short period, and the report will be exported to the 
following location: 
[YOUR_DRIVE]:\ProgramData\NoravMedical\NEMS\ECGDBase\Reports 

◦ If no report is associated with the selected record, a report will be generated and 
exported to the same location: 
[YOUR_DRIVE]:\ProgramData\NoravMedical\NEMS\ECGDBase\Reports 

4. After the export is complete, the record will be marked with a green checkmark in 
the Exported and Reported columns of the Records List. 

Figure 89. Records Tab - Reported and Exported Marks 

Figure 90. Records Tab - Test Date Column 
 

Copying Records 
When a user copies a record, a corresponding log entry is created in the application's 

Note: Users will be able to access this report within the application using the View Report button. Alternatively, users can access a 
PDF containing the report in the following location, if needed:  

[YOUR_DRIVE]:\ProgramData\NoravMedical\NEMS\ECGDBase\Reports\[TEST_DATE_YEAR]\[TEST_DATE_MONTH] 

[TEST_DATE_YEAR] and [TEST_DATE_MONTH] correspond to the year and month from the Test Date column of the specific record. 

For example, if the Test Date of the record is 13/08/2024 (MM/DD/YYYY), the path to the record may look like this: 

 C:\ProgramData\NoravMedical\NEMS\ECGDBase\Reports\2024\8 
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database along with the record's copy. This entry contains the name of the copy, the 
timestamp, the full path to the folder containing the copy, and any remarks. The Copy 
button provides access not only to copying patient records but also to managing the log of 
the created copies. 
 
To copy a patient's record: 

Figure 91. Records Tab - Actions Bar - Copy 

 
1. Select a record in the Records List. 
2. Click the Copy button in the Actions Bar. The Copy dialog box will be displayed. 

Figure 92. Records Tab - Copy - Copy Dialog Box 
3. Click the Explore icon to open the Browse For Folder dialog box: 

Figure 93. Records Tab - Copy - Setting Path 
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3.1. Navigate to the location you need and choose a relevant folder. 
Figure 94. First Launch Set Up - Browse For Folder 

 
3.2. (Optional) To create a new folder, click Make New Folder in the bottom-left 

corner of the dialog box and type in the folder name manually. 
3.3. After you have selected the folder, click OK to confirm the path. 

4. (Optional) Enter remarks in the Remarks text field, if needed. Remarks serve as notes 
where you can include any relevant information about the backup you create. 

5. Click OK to create a copy of the selected record and save it in the folder you have 
selected. 

Figure 95. Records Tab - Copy - Creating Copy 

 
To access log entries: 

1. Select a record in the Records List. 
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2. Click the Copy button in the Actions Bar. The Copy dialog box will be displayed. 
Figure 96. Records Tab - Copy - Copy Dialog Box 

3. Click the Search icon next to the Backup text field. The Backup dialog box will be 
displayed. 

Figure 97. Records Tab - Copy - Search 

4. Click the Name drop-down menu to expand it. 
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Figure 98. Records Tab - Copy - Name Drop-Down Menu 
5. Select the relevant name of the copy you made earlier to access the log entry. The copy 

creation timestamp, the path to the copy, and the remarks will be displayed within the 
Backup dialog box. You cannot edit any of the entry's data within this dialog box. 

Figure 99. Records Tab - Copy - Accessing Log Entry 
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After you have selected a log entry and the entry information is displayed, you can do 
the following: 

Figure 100. Records Tab - Copy - Log Entry Data 

 
• Update the remarks. 
• Return to the Copy dialog box. 
• Delete the entry. 

 
To update the remarks: 

1. Access the log entry you need by following the instructions above. 
2. Click OK when the requested log entry data is displayed. 

Figure 101. Records Tab - Copy - Editing Log Entry 
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3. You will be redirected to the Copy dialog box. The same copy creation timestamp, the 
path to the copy and the remarks as in the Backup dialog box will be displayed in the 
Copy dialog box. 

4. Edit the content within the Remarks text field as needed. This text field is editable 
within the Copy dialog box, unlike in the Backup dialog box. 

Figure 102. Records Tab - Copy - Editing Remarks 
5. Click OK to save the changes in the Remarks of the log entry. 

 
To return to the Copy dialog box: 

Figure 103. Records Tab - Copy - Return to Copy Dialog Box 
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1. Click Cancel. 
 

To delete the selected log entry: 
1. Access the log entry you need, following the instructions above. 
2. Click Delete. 

Figure 104. Records Tab - Copy - Delete Log Entry 

3. A pop-up warning window will be displayed (see below). 
Figure 105. Records Tab - Copy - Delete Warning 

4. Click OK to delete the selected log entry. 
 

Moving Records 
The Move function's user interface closely resembles that of the Copy function, sharing 
many key features. Like the Copy function, the Move action allows you to transfer existing 
records to an external location and remove them from the NEMS- A system. It also 
provides similar log management functions as the Copy function. For further details, refer to 
the Copying Records section. 
 
To move a patient's record: 
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Figure 106. Records Tab - Actions Bar - Move 
1. Select a record in the Records List. 
2. Click the Move button in the Actions Bar. The Move dialog box will be displayed. 

Figure 107. Records Tab - Move - Move Dialog Box 

3. Enter the copy name in the Backup text field. 
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Figure 108. Records Tab - Move - Backup Name 

4. Click the Explore icon to open the Browse For Folder dialog box: 

Figure 109. Records Tab - Move - Setting Path 
4.1. Navigate to the location you need and choose a relevant folder. 
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Figure 110. First Launch Set Up - Browse For Folder 

 
4.2. (Optional) To create a new folder, click Make New Folder in the bottom-left 

corner of the dialog box and type in the folder name manually. 
4.3. After you have selected the folder, click OK to confirm the path. 

5. (Optional) Enter remarks in the Remarks text field, if needed. 
6. Select one of the available options under Move Studies Options: 

Figure 111. Records Tab - Move - Move Options 
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◦ Click "Remove study, but leave properties" to move the record but keep the 
record information in the Records List. In this case, all the record's data in the 
Records List remains intact, but the record itself and related report are no longer 
accessible within the system. 

 
Figure 112. Records Tab - Move - Record Moved, Data Kept 

◦ Click "Remove entire study" to move the record and remove all the record 
information from the Records List. Both the record and its data are removed 
from the system. 

7. Click OK to confirm your choice and move the selected record to the selected folder. 
Figure 113. Records Tab - Move - Moving Copy 

 
Deleting Records 
To delete a patient's record: 

Note: You will be able to remove the record's data from the Records List anytime using the Delete button in the Actions Bar. 
For more details, refer to the subsection about deleting the records. 
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Figure 114. Records Tab - Actions Bar - Delete 

 
1. Select a record in the Records List. 
2. Click the Delete button in the Actions Bar. The Delete dialog box will be displayed. 

Figure 115. Records Tab - Delete - Delete Dialog Box 
3. Select one of the available options: 

Figure 116. Records Tab - Delete - Delete Options 

 
◦ Click "Remove study, but leave properties" to remove the record from the 

system but keep the record information in the Records List. In this case, all the 
record's data in the Records List remains intact, but the record itself and related 
report are no longer accessible within the system. 
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Figure 117. Records Tab - Delete - Record Removed, Data Kept 

 
◦ Click "Remove entire study" to remove the record and all the record 

information from the Records List. Both the record and its data are removed 
from the system. 

Figure 118. Records Tab - Delete - Record and Data Removed 

 
4. Click Yes to confirm your choice and remove the record. 

Figure 119. Records Tab - Delete - Removing Record 

 
Reassigning Records 
To reassign a patient's record: 

Note: Use this option of the Delete action to completely remove a record's data if you previously moved or deleted a 
record using the "Remove study, but leave properties" option. This option is available for both the Move and Delete 
actions. 
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Figure 120. Records Tab - Actions Bar - Reassign 

 
1. Select a record in the Records List. 
2. Click the Reassign button in the Actions Bar. The Reassign test to another patient 

dialog box will be displayed. 

Figure 121. Records Tab - Reassign - Reassign Dialog Box 
 

3. Enter any of the patient credentials in the Patient ID, MRN, Last Name, or First 
Name search fields within the dialog box. To perform a search, you must enter at least 
one character in one of these fields. You can also enter values in multiple fields to refine 
your search using different parameters. For example, you may enter "1" in the Patient ID 
search field to get a list of all patients with IDs containing "1." 

Figure 122. Records Tab - Reassign - Entering Search Parameters 
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4. Click the Get Patient button when you have entered all the search values you wanted: 
◦ If your search parameters return multiple matches, a list of potential matches will be 

displayed to the right of the dialog box. Click the result you are looking for, and the 
relevant text fields within the Database section will be populated with the match's 
data. 

Figure 123. Records Tab - Reassign - Multiple Matches 

◦ If your search parameters return an exact match, the relevant text fields within the 
Database section on the right will be populated with the match's data. In this case, no 
list of matches will be displayed. 

Figure 124. Records Tab - Reassign - Exact Match 

5. Click the Reassign button to assign the record on the left to the patient displayed on the 
right. A "Patient Data Changed!" warning will appear on the left side of the dialog box, 
and the updated patient's data will be highlighted in red. 

Note: The Gender and DOB (Date of Birth) fields are for display purposes only and will be populated with search results. These fields 
cannot be used to search for patients. 
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Figure 125. Records Tab - Reassign - Reassign 

 
6. Click the Save button to save the record with the new patient's data, reassigning it to the 

new patient. 
Figure 126. Records Tab - Reassign - Save 

 
 

Reviewing Records 
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To review a record: 
Figure 127. Records Tab - Actions Bar - Review 

 
1. Select a record in the Records List. 
2. Click the Review button. 
3. Depending on the Type of record, the corresponding app will be launched: 

◦ PC-ECG 1200: For Rest and Stress records. 
Figure 128. Records Tab - Review - Rest Application Launched 

◦ NH-301: For Holter records. 

Figure 129. Records Tab - Review - NH-301 Application Launched 
◦ NEMS-A: ABPM records are opened directly within the NEMS-A application, with 

no external or additional apps needed. 
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Figure 130. Records Tab - Review - Reviewing ABPM Record 

4. Wait until the relevant app is launched and the selected record is loaded for review. 
Proceed with the review after that. 

5. (Optional) If you launched the PC-ECG 1200 (Stress, Rest) or NH-301 app, you may 
need to close it after reviewing a record: 

◦ Stress and NH-301: Use File > Exit option or the standard Windows Close 
button. 

◦ Rest: Click the Exit button in the bottom-right corner. 
 

Viewing Reports 
To view a report associated with a patient's record: 

Figure 131. Records Tab - Actions Bar - View Report 

1. Select a record in the Records List. 
2. Click the View Report button. 
3. If you have opted to view a Rest, Stress, or Holter report, a progress indicator pop-up 

will be displayed. 
Figure 132. Records Tab - View Report - Progress Indicator 

4. After a short period of time, the report associated with the selected record will be 
opened: 

◦ For Rest, Stress, and Holter reports: In the PDF viewer installed on your PC. 
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Figure 133. Record Tab - View Report - Stress Report 

◦ For ABPM reports: Directly within the NEMS-A system. 
 

Records List 
Records List is an essential part of theRecords tab, containing all the records' data 
displayed within appropriate columns. Within the Records List, you can sort the records 
using column headers and the context menu, turn columns ON and OFF to your liking, 
access records' properties, and more. 

Figure 134. Records Tab - Records List 

 
Managing Columns 
Records List enables users to sort records using column sorting functions. Column sorting 
toggles the sorting order in a column between ascending and descending and allows users to 
revert back to the default ("unsorted") state. After changing the order in a column, all 
records in the list will be rearranged accordingly. 
Users can also arrange columns in the preferred order and turn them ON/OFF, including 
fields like Patient ID, First Name, Last Name, Test Date, and others. 
 
To toggle column sorting order: 

1. Hover your mouse cursor over the header of a column you want to use for sorting 
(e.g., the Patient ID column). 

2. Change the sorting order using one of the following methods: 
◦ Click the column header to switch between sorting orders. The records will be 

rearranged in the corresponding order (ascending or descending). The arrow 
icon on top of the column header will change accordingly. 
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Figure 135. Records Tab - Records List - Switching Sorting Order 

◦ Right-click a column header to open the context menu and select one of the 
available options: Sort ascending by, Sort descending by, or Unsort. The 
Unsort option reverts the sorting to the "default" sorting state. 

Figure 136. Records Tab - Records List - Column Header Context Menu 

 
To turn columns ON/OFF or adjust the visibility of displayed columns: 
1. Right-click a column header to open the context menu. 

Figure 137. Records Tab - Records List - Select Columns 

 
2. Click on the Select Columns option. The Column Selection dialog box will be 

displayed. 
Figure 138. Records Tab - Records List - Column Selection Dialog Box 

 
3. (Optional) To toggle any of the 25 available columns ON/OFF, excluding the Type 
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column: 
◦ Click a checkbox next to the relevant column name (e.g., Patient ID, First Name, 

Test Date) to toggle it ON or OFF. 
◦ Select a column to toggle ON/OFF and click the Show or Hide button on the right 

to display or hide this column. 
4. (Optional) To move a column forward (up in the list) or backward (down in the list) in 

the records list: 
◦ Select a column to move and click Move Up on the right to shift it one position up 

in the dialog box and forward in the records list. This action can be repeated multiple 
times. 

◦ Select a column to move and click Move Down to shift it one position down in the 
dialog box and backward in the records list. This action can be repeated multiple 
times. 

5. Click OK to save the changes. 

 
Managing Records 
Records List also provides the capability to select or deselect all records and presents 
comprehensive data about the records through a dedicated context menu. 

Figure 139. Records Tab - Records List - Records List Context Menu 
 

Option Description 
Properties Click this option to access the details of the selected record. 
Select All Click this option to select all records in the Records List for bulk actions. 
Deselect All Click this option to deselect all records in the Records List. 

 
To access record details: 
1. Hover over the specific record you want to obtain data about. 
2. Right-click to open the context menu. 

Note: The Type column cannot be turned off as it contains data about the test type. You can only change the position of this column using the 
Move Up and Move Down buttons in the Column Selection dialog box. 
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Figure 140. Records Tab - Records List - Properties 

 
3. Click Properties. The Properties pop-up window will be displayed. 
4. Switch between the General, File, and Description tabs to access relevant record details. 

Please find more information on the tab content below. 

Figure 141. Records Tab - Records List - Properties 
The General tab of the Properties pop-up contains standard record data visible in the 
Records List, such as test type, start and end test date, patient details, referring physician, 
etc., along with some additional information, as shown in the image below. 
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Figure 142. Records Tab - Records List - General Tab 
 

The File tab contains the test file data: 
• File Name: Name of the file containing the test. 
• File Date: The date when it was created or imported into the system. 
• Path: Full path to the file. 
• Size: The size of the file in bytes. 
• Report Name: The name of the report associated with the test file. 
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Figure 143. Records Tab - Records List - File Tab 
 

The Description tab contains the test conclusion and remarks made by the medical 
personnel within the relevant application. 

Figure 144. Records Tab - Records List - Description Tab 

 

Preview Panel 
The Preview Panel facilitates fast preview of example strips from Rest ECGs (not available 
for Stress) or blood pressure tests (ABPM), derived from the record. 
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Figure 145. Records Tab - Preview Panel - Rest Example Strip 
 

Figure 146. Records Tab - Preview Panel - ABPM Example Strip 
 

The Preview Panel is a Records tab element that can be turned ON or OFF. To turn the 
Preview Panel ON, check the checkbox next to the Show ECGs option in the View tab of 
the Setup dialog box (Setup > View > Records Tab). For more detailed instructions on 
how to turn the Preview Panel ON/OFF, refer to the View tab section. 

Figure 147. Setup - View - Records - Show ECGs 
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Measurements Function 
When the Preview Panel is turned ON, you can see the Measurements button in the 
upper-left corner, right above the panel itself. This button is only active when a Rest record 
is selected in the Records List. 

Figure 148. Records Tab - Preview Panel - Measurements Button 

Click the Measurements button to open the Measurements window. It provides fast 
access to test measurements and interpretation without the need to review the test within the 
Rest application. 

Figure 149. Records Tab - Preview Panel - Measurements Window 

 
Records Counter 
The Records Counter is located in the bottom-left corner of the Records tab, right below 
the Preview Panel (when it's turned ON). It displays the number of records (tests) shown in 
the Records List at any given moment. In other words, it shows the number of records 
based on the search criteria selected by the user in the Filters Pane. 
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Figure 150. Records Tab - Preview Panel - Records Counter 
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Patients Tab 
The purpose of the patient module is to manage the patients, search for specific patient or 
group of patient, view the patient tests (records), and perform actions on specific tests  
(e.g., View, Compare, Review). 

 
Figure 151: Patients Screen 

Patients Tab Buttons 

Tab Description 

 
Editing patient details  

 
Adding new patient  

 
Deleting patient  

 
Moving patient to another group  

 
Creating new test for selected patient  

 
Viewing patient's test  

 
Comparing patient's tests  

 
Viewing the selected report  

 
Reviewing the selected test  
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Editing Patient 

The system administrator can change the patient demographic information in case of 
missing details or wrong input. To change the patient information, follow the next steps: 

1. To edit the patient details (administrator only), select (highlight) the patient, and click            . 

The Patient Details Dialog Box is displayed. 

 
Figure 152: Patient Details Dialog Box 

2. Under the Personal tab, click                       and edit the details. 
Or 

Click                      , select a patient from the                                 Dialog Box, and then 

click                       on the                                 Dialog Box. 

Click                       on the Patient Details Dialog Box. 

To edit the patient address, click the                   tab. 
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The Address Dialog Box is displayed. 

 
Figure 153: Address Dialog Box 

Under the Address tab, click                       and edit the details. 

Click                       on the Address Dialog Box. 

To edit the patient Medications, Indications, and Other, click the               tab. 

 
Figure 154: Other Dialog Box 

Under the Other tab, click                       and edit the details. 

Click                       on the Other Dialog Box. 
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Adding New Patient 

1. To add a new patient, click             . 

The Personal Dialog Box is displayed. 

 
Figure 155: Personal Dialog Box 

2. Add the new patient's details: Patient ID, MRN, Last Name, First Name, Birth Date, 
Gender, Weight, and Height. 

3. To look for an existing patient, open the Patients Screen, fill in the Patient ID, and 

then click                     . 

The patient is displayed on the patient list, after selecting the patient please click                      . 

Or 

Click                      , select a patient from the                                 Dialog Box, and then 

click                       on the                                 Dialog Box. 

4. Click                       on the Personal Dialog Box. 

5. To add the new patient address, click the                   tab. 
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The Address Dialog Box is displayed. 

 
Figure 156: Address Dialog Box 

6. Fill all details. 

7. Click                       on the Address Dialog Box. 

To edit the patient Medications, Indications, and Other, click the             tab. 
The Other Dialog Box is displayed. 

 
Figure 157: Other Dialog Box 

Fill all details. 

Click                       on the Other Dialog Box. 
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Deleting Patient 

1. To delete a patient along with all attached tests (administrator only), select (highlight) 
the patient, and click               . 

 
Figure 158: Deleting Patient from Patients Screen 

The following message is displayed: 

 
Click                 . 

The following message is displayed: 

 
Click                 . 

The selected patient with all attached tests is deleted. 
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Moving Patient from One Group to Another 

1. To move a patient to another group, select (highlight) the patient, and click              . 

The Groups Window is displayed on the screen under the              button. 

 
Figure 159: Moving Patient to another Group Screen 

Click (select) a group from the Groups Window. 
The selected patient is moved to the selected group. 
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Creating New Test 

1. To create a new test, select (highlight) the patient and click                  . 

The Test Type List Window is displayed under the                   button. 

For test type descriptions, see the table below. 

 
Figure 160: Test Type List Window 

Test Type Descriptions 

2. Select the required test type from the list. 
The corresponding test application is opened. 

Viewing Patient Test 

To view a patient's test (report), select (highlight) the required test on the bottom pane and 

click             on the bottom pane. 
The corresponding test application is opened, allowing viewing the test. 

Test Type Description 

Rest ECG test through repeated cardiac cycles during rest (10 seconds minimum) at clinic. 

Stress ECG test through repeated cardiac cycles during exercise at clinic. 

Holter ECG test using a portable recorder for 24 hours to two weeks at home. Available 
options: NR Patch (NR-314-P device) or NR (all other NR-series Holter devices, 
excluding NR-314-P). 

NBP-24 NG 24-hour Ambulatory Blood Pressure Monitoring using the NBP-24 NG recorder. 

LP Signal-averaged electrocardiogram (SAECG) testing performed to identify low-
amplitude late-potentials, typically at the end of the QRS complex, aiding in 
identification of increased risk for ventricular tachycardia. 

HRV Heart Rate Variability (time intervals between heartbeats) testing. 

Monitoring ECG Monitoring test during activity (ergometer, treadmill, etc.). 

Spirometer Pulmonary Analysis. 

ABPM 24-hour Ambulatory Blood Pressure Monitoring using the NBP One or Oscar 2 
recorder directly via NEMS-Q, NEMS-A, or NEMS Web. 
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Comparing Patient Tests 
To compare two or more patient Rest tests, select (highlight) the tests, and then click                  
. 

 
Figure 161: Selecting Tests for Comparison Screen 

The Resting ECG application is opened, displaying the compared tests. 

 
Figure 162: Comparing Tests Screen 
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Viewing Report 

To view patient test report, select (highlight) the test, and then click                   . 
The report of the selected test is displayed. 

Reviewing Test 

To review patient test report (physician only), select (highlight) the test, and then click               . 
The corresponding application is opened, displaying the test for physician review, and 
allowing adding remarks. 
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Manage Tab 
The Manage tab enables the creation of user groups, as well as referring physicians, 
technicians, and reporting MDs lists.  

Figure 163: Manage Screen 
Patient groups can be created in the Manage tab. After creating a Group, you can add patients 
to it and search for them in the Records tab using this filter. You need to create relevant groups 
first to use them for filtering records. There is only one predefined default patient group named 
All, which includes all patients within the system. For more detailed information about groups 

1. To add a group, click                                   and then click                  . 

The Add Dialog Box is displayed. 

 
Figure 164: Add Dialog Box 

Fill the group name, and then click                  . 

The group is added to the Groups list. 

To edit a group, select (highlight) the group and click                  . 

The Edit Dialog Box is displayed. 

 
Figure 165: Edit Dialog Box 
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Edit the group name and then click                  . 

 

To delete a group, click                  . 

The Delete Dialog Box is displayed. 

 
Figure 166: Delete Dialog Box 

Click                 . 

All other types of groups work the same way. 
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Devices Tab 
The Devices tab allows scanning connected Holter Recorder and downloading patient test to 
NEMS-A. 

 
Figure 167: Devices Screen 

1. Connect the recorder and click the                               button. 

The Patient Details Screen is displayed. 

 
Figure 168: Patient Details Screen 

2. To download the test (record) to NEMS-A, click                              . 

3. To replace the patient details if the patient already exists in the DB, type the first digit of 

the patient's ID and click                     . 

The Patient List Window is displayed. 

 
Figure 169: Patient List Window 

4. Select the patient from the list. 
The selected patient's details are displayed on the Patient Details screen. 

5. To clear the patient's details, click                     . 
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Working with the NH-301 Holter Analysis System 
The following operations are specific for operating NEMS-A together with the NH-301 app: 

Preparing Holter Recorder for New Patient 

Downloading ECG Recording from Holter Recorder 

Reviewing ECG Record using NH-301 Software 

Preparing Holter Recorder for New Patient 
Preparing a Holter recorder involves sending patient data to the recorder before starting 
the test. The NEMS-A application supports two preparation flows: 

• Via USB connection – used when the recorder is physically connected to the 
PC or when its memory card is inserted via a card reader. 

• Via Bluetooth connection – used when the recorder is paired with the PC via 
Bluetooth. This method enables the Check ECG function, which allows users to 
verify the quality of the ECG signal and the electrode connections in real time 
before sending data to the recorder. For more details on connecting recorders to 
the PC, refer to the Pairing Norav Devices via Bluetooth section of the NH-
301 Instructions for Use. 

Both methods follow similar steps for selecting a patient and assigning test details, but 
the Bluetooth-based flow includes optional signal verification using the Check ECG 
button. 
 
To prepare the recorder using a USB connection:  

1. Select a patient in the Patients Screen, and then click New Test. 

Figure 170: Start New Test 
2. In the New Test drop-down menu, hover over Holter, and then select either: 

• NR to prepare any of the NR recorder models except NR-314-P; 
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• NR Patch to prepare specifically the NR-314-P recorder model. 

Figure 171: Select Recorder Type 
 

3. The Patient Details window is displayed. Verify and complete patient demographics, 
including Patient ID, First Name, Last Name, Birth Date, and Order, if available (see 
Figure 172: Patient Details Window). 

Figure 172: Patient Details Window 

 

 
Note 

If the recorder memory contains a test record, a warning message will appear (see 
below). Click Devices, switch to the Devices tab, and download the existing 
record. For more details, refer to Downloading ECG Recording from Holter 
Recorder. 

 

 
Note 

It is important to complete patient demographics (Patient ID, First Name, 
Last Name, Birth Date, and Order, if available). 
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4. Once the patient’s demographics are complete and verified, click Send to Device in the 
NEMS-A app. 

Figure 173: Send to Device  

5. Wait until the recorder preparation is complete. A status message will be displayed. Click 
OK to dismiss the message. Now you may disconnect the Holter recorder or the 
memory card from the PC. 

Figure 174: Status Message - NEMS-A  

6. Hook up the patient. Once everything is ready and the electrodes are properly connected, 
you may proceed with the test. 
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To prepare the recorder using a Bluetooth connection:  

1. Connect the recorder via Bluetooth and follow Steps 1-3 of the instruction above on 
how to prepare the recorder using a USB connection.  

2. (Optional) For a Bluetooth connection: When the patient is hooked up, you may click 
the Check ECG button to verify electrode connection and signal quality: 

Figure 175: Check ECG – NEMS-A  

1. Click Check ECG. The Norav Holter Device Manager application will be 
launched. Wait until the recorder selection screen is displayed. 

Figure 176: Norav Holter Device Manager Launcher 
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2. Select the Bluetooth-connected recorder from the list. If the recorder does not 
appear, click Refresh in the bottom-left corner and recheck. If it still does not 
appear, verify your Bluetooth connection. 

Figure 177: Select Recorder 

3. Click Connect in the bottom-right corner. The Record Information screen will 
appear, containing the Personal Information of the patient and Record 
Information. 

Figure 178: Click Check ECG 

4. Click Check ECG again in the bottom-right corner. A pop-up window will 
stream the ECG signal and indicate the electrode connection status. If any 
electrode is marked OFF and the signal is absent or distorted, adjust the 
connection and retry. 
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Figure 179: ECG Streaming 

4. Once electrode connections are verified and rectified if needed, click Send To Device in 
the Device Manager app. 

Figure 180: Send to Device – Device Manager 

5. Wait until the recorder preparation is complete. A status message will be displayed. Click 
OK to dismiss the message. 

Figure 181: Status Message – Device Manager 

6. Once everything is ready and the electrodes are properly connected, you may proceed 
with the test. 
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Downloading ECG Recording from Holter Recorder 
1. After the test is complete, make sure the Holter recorder is connected to the PC, or the 

Holter Memory Card is connected to the PC via the Card Reader device. 

2. Click the                      tab, and then click the                                button. 

The Patient Details Screen is displayed. 

Figure 182: Patient Details Screen 

3. Validate or edit the patient details, and then click the                                 button. 

 
Note 

If a record already exists in the system, a warning message (see the image below) will 
appear with two options: Clear the recorder memory (to remove the record) or 
<Back (to return to the previous screen). 

4. You will be prompted with the Download Complete dialog box, indicating that the test 

was successfully downloaded to the NEMS-A system. 

Figure 183: Download Complete Dialog Box 
5. (Optional) To remove the downloaded record from the recorder, leave the Clear 

recorder memory option checked. To keep the record in the recorder memory, uncheck 
the Clear recorder memory option. 
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6. Click Close to proceed without analyzing the downloaded record, or Analyze to analyze 
the record immediately. Depending on whether the Clear recorder memory option is 
checked, the record will either be removed from the recorder memory or kept intact. 

7. Disconnect the Holter Recorder or the Memory Card from the PC. 

 

Reviewing ECG Record using NH-301 Software 

 
Note 

The NH-301 Holter software license is required. 

To open a Holter recording, click the                  tab, select a Holter test, and then click the               
button on the record list toolbar. 
For detailed description, refer to the NH-301 IFU – Reviewing and Editing ECG Recording. 
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Working with the PC-ECG 1200 System 
The PC-ECG 1200 software is required with the PC-ECG 1200 software license. 

The following operations are specific for operating NEMS-A with the PC-ECG 1200 system. 

Starting New ECG Test  

Opening Rest ECG Record for Review  

Starting New ECG Test 
1. To start a new test from the Patients Screen, select (highlight) the patient, click the  

                button, and then select the test type from the drop-down list. 

 
Figure 184: Starting New Test from Patients Screen 

After the ECG recording is finished, click               to close the PC-ECG 1200 application. 

The ECG recording is automatically imported from the database and displayed on the 
patient's recording list. 
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Opening Rest ECG Record for Review 
Select an ECG test (physician only) from the recording list and then click the               
button. 

 
Figure 185: Opening Rest ECG Recording for Review 

The Rest ECG recording is opened in the PC-ECG 1200 program interface. 

 
Figure 186: Rest ECG Recording Opened for Review 
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Click on the Interpretation window (with automatic Interpretation and Remarks) on the top 
right of the screen (highlighted blue). 

 
Figure 187: Adding Remarks to Rest ECG Recording 

The Remarks Dialog Box is displayed. 

 
Figure 188: Remarks Dialog Box 

Write remark(s) and click                    . 
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The written remark(s) are added. 
Or  
To add remark template(s), click             . 

The Expert Interpretation Dialog Box is displayed. 

 
Figure 189: Expert Interpretation Box 

Select the appropriate remark template(s) from the      folder(s) and click                . 

The selected remark template(s) is displayed on the Remarks Dialog Box. 

 
Figure 190: Remarks Dialog Box with Added Remark 

To save the added remark template(s), click                     . 

Click  to close the application. 
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Opening Stress ECG Record for Review 

1. Select a Stress ECG test (physician only) from the records list, and then click the 
Review button. 

Figure 191: Opening Rest ECG Recording for Review 

2. The Stress ECG recording opens in the PC-ECG 1200 program interface. 

Figure 192: Adding Remarks to Stress ECG Recording 

3. Enter the required information in the Remarks window, including the Conclusions 
and Medications fields. 

4. Click the Confirm button to save the changes. 

5. Close the application. 
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Downloading ECG+ Recordings from NR-1207-3 
1. Connect the NR-1207-3 recorder, which contains the data acquired in the ECG+ mode, to  

the PC using a USB cable or insert the NR-1207-3 recorder Memory Card into the card reader. 

Click the                     tab and then click the                                button. 

The list of ECG records in the NR-1207-3 recorder Memory Card is displayed. 

Validate or edit the records one-by-one on the download list. The edited data is displayed in red. 

To apply the changes after editing the patient data, click the         button. 

To select the records for download, mark the        checkbox(es), and then click the  

                              button. 

 
Figure 193: Selecting Records for Download 

Wait until the procedure ends. 

The successfully downloaded records are marked         on the Status column,  

and any unsuccessful downloaded records are indicated        . 

Disconnect the NR-1207-3 recorder or the Memory Card from the PC. 

Click the                      tab and validate that all new Resting ECG records appear on the list. 
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ABPM Module 

Operating Environment 
Windows 10 Pro 32/64 bit or Windows 11 Pro 
4 GB RAM 
Core i5 CPU 
.Net Framework 4.7.2 
SQL Server Express 2019 
USB port 

Product Functions 
1. Connect to ABPM device (Oscar 2, NBP One) via USB. 
Select/Create Patient 

Select Patient -> New Test -> Select ABPM test. 
Later – Select NBP-24 NG test. 

Prepare recorder for ABPM test (see Section Preparing NBP One Recorder for New ABPM 
Test). 

Download the ABPM recording from the recorder (see Section Downloading ABPM 
Recording from NBP One Recorder). 

Preview the ABPM results in Record List (see Section Previewing Test Results). 
Review the ABPM examination results (see Section Reviewing ABPM Recording in NEMS-

A). 
Report types (see Section Report Types): 

Ambulatory Blood Pressure Report 
Patient Information 
BP Profile 
Bar Chart 
Measurements 
Diastolic vs Systolic Graph 
Pie Chart 
Summary Report 

Setup 
ABPM-related parameters 
Measurement Schedule 

Specifies when and how often the monitor takes readings.  
For Awake Time and Asleep Time, select from the Hour drop-down menu to establish the 
start time for these periods.  
From the Brachial BP Interval drop-down menus, select the desired interval between 
readings (5, 10, 15, 20, 30, 45, 60, 90, or 120 minutes. 
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When downloading a test from the BP device, you can change the Awake Time, Asleep Time, or 
change the values (see following Figure). 

 
Start study in 5 minutes option: the study starts automatically after programming. 
The physician is allowed to change day and night intervals (Prepare, Download, Edit). 
The measurements table out of limits is in red based on limit settings (see following Figure). 
Manual Measurement events are displayed in the Events field (see following Figure). 

 
Advanced Options: 

Max. Pressure – Establishes the maximum inflation pressure for the monitor  
(160 mmHg to 280 mmHg).  
Suggested setting is 30 mmHg above the highest expected systolic BP. 

Display Results – When ON, allows viewing the results immediately after a measurement. 
Manual Readings - When ON, allows the taking measurements outside the scheduled 

program using the Start/Stop button.  
Day/Night button – When ON, enables the Day/Night button on the monitor allowing the 

patient to start the Awake and Asleep periods according to their daily schedule.  
A period can be started up to four hours before the programmed period begins. 

Audible Alerts – Play an alert sound at the beginning and upon completion of each 
reading, during the Awake period only. 

Retry Attempts – The monitor reattempts a measurement that initially failed. 
Automatically open a patient file directly after the data is retrieved. 

Viewing an Ambulatory Blood Pressure study: 
ABP Data – ABP measurement data from the monitor and relevant graphs. 
Patient Info – Demographic info: patient name, DOB, sex, patient ID, contact 

information, physical description, medications, indications. 
Clinic Info – Clinical information (site). 
Statistics – Statistical analysis of the ABP study. 
Summary –Interpretative summary settings and results for current study. 

Events Diary, containing managed list with Date and Time. 

 
Note 

After changing, the raw data is saved. 
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Blood Pressure Limits for existing patients & global system limits (see following Figure). 
The source of average values is the SQL tables (children and adults) hypertension limits. 
The values can be changed by the user and have a button for Standard (which restores the 
values from SQL). 
The average values are included in the review pane (Total = Round (Day+Night)/2). 

 
Various Export File types: CSV, PDF, NBP (Norav Blood Pressure) 
The ABPM module allows comparing current patient record(s) with multiple history records. 
Ordering the ABPM devices: 

NBP-24 NG  
NBP One 
Oscar 2 

ABPM Settings Screen 
See following Figure. 

 
You can specify global thresholds for Systolic and Diastolic blood pressure. 

When these values are exceeded, the measurements are marked accordingly in the analysis. 

These values are automatically stored as limits for new patients.  

Recent studies (Blood Pressure percentiles by Age and Height) have shown that the limit 
depends on age and gender in children and adolescents. The European Society for 
Hypertension (ESH) published comprehensive tables, which constitute the basis of the 
thresholds set for the Norav ABPM. 

The thresholds are determined based on 95% percentile curve. The limit value can then be 
defined as one which is either equal or lower for 95% of a whole study (statistic report on 
children). Any values above this limit are defined as hypertension. 

Working with the percentile curve: To display the percentile curve (P95) (only for children and 
adolescents from 4 to 18 years of age), the patient's date of birth must be entered; then this 
data will be the basis for the calculation of the patient's age. 

Important: The analysis always refers to the current age of the patient.  
Displaying a patient's history requires one print per appointment. 

 
Note 

You can set BP limits for each patient individually on the Patient Information pane. 
BP Limits affect the calculation for the graphs and reports. 
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ABPM Customized Report 
Customization allows defining the report Header title, Footer title, and Physician Endorsement 
with an option for digital signature (see following Figure). 

 

1. On the ABPM Review Screen, click the                                 button. 

The Customization Dialog Box is opened (see following Figure). 

 
Select the       of the items to be included in the report (see Figure above). 

The selected items are saved (as global settings). Default settings include all reports. 

Click                       (see Figure above). 
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Preparing ABPM Recorder for Test 
See following Figures. 

Preparing the ABPM recorder for an ABP study involves filling out an onscreen form to set 
the parameters for your study to be programmed into the monitor.  

You can also use a template to fill out the form. Templates help ensure consistent 
programming and adherence to specific protocols. The NBP One Software provides default 
templates, or you can create your own. 
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Editing Patient Medical Info History 
(See Section Patient Information). 
The purpose is allowing the user to modify medical history and medications for awareness of 
the physician/clinicians (see Figure below). 
The user can add/edit/delete medical history (diseases) and medications (see Figures below). 
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1. To add Medical History and Medication, click the                   button. 

2. Enter the Disease name in the Disease field and/or Medication Trade Name in the 
Trade name field. 

3. Enter the From and To dates in the Medical History and in the Medication Dialog Boxes. 

4. On the Medication Dialog Box, enter the Agent's Name in the Active Agent field,  
and the Medication Dosage in the Dosage field. 

5. Enter notes in the Medical History and in the Medication Dialog Boxes. 

6. To save, click                   or click                   to abort. 

7. To edit existing Diseases and/or Medications click                  , make changes, and then 
click                   to save. 

8. To delete existing Diseases and/or Medications, select (highlight) the Diseases and/or 
Medications for deletion, and click                  . 

Downloading ABPM Recording 
See following Figure and Section Downloading ABPM Recording from NBP One Recorder. 

 

'OSCAR2'  ----------  S/N: 1001 

32011111111 

Gorbunov 

Oleg 

14/02/1966 52 

06/07/2016 14:29 00:11:29 
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Previewing Test Results 
See following Figure. 

Preview the ABPM results in the Records window. The blood pressure profile graph is 
displayed when clicking on a specific patient record. 

The common layout is like the Resting ECG preview window (setup-enabled). 

 
The white areas represent Awake Time, and the blue-highlighted area represent Asleep Time. 

The top chart is the Systolic BP chart, and the bottom chart is the Diastolic BP chart. 

The red areas represent BP higher than the BP Limit (preset per patient before ABPM), 
which is represented by the straight horizontal line on the bottom of the red areas. 

The green areas represent BP lower than the BP Limit (preset per patient before ABPM), 
which is represented by the straight horizontal line above the green areas. 

The blue chart, which is superimposed on the bottom Diastolic BP chart, is the HR chart. 
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Reviewing ABPM Recording 
See Section Reviewing ABPM Recording in NEMS-A. 

You can access all functions from the main ABPM window (see Figure below). More windows 
may appear depending on the function. 

Patient & Test Information Panel (left side) 
Patient ID, MRN, Last Name, First Name, Birth Date, Age, Gender, Weight, Height, 
Order (Test-ID), Test Date, ABPM Recorder Type, Serial Number 

Common Actions Toolbar (on top of BP measurements table) 
Print, Export, Preview Report, View Report, Customized Report, Send Report, Save 
Report 

ABPM Review Panel 
BP Measurements Table 
Referring MD, Reporting MD, Technician drop-down menus 
Physician Comments text field 
Awake Time, Asleep Time parameters 
Interpretive Summary (automatically generated based on the test results) 
BP Limits as JNC7/AHA or Custom blood pressure thresholds. 
Blood Pressure Tab with BP Graph (default) and related subtabs. 
Patient Information Tab, containing Medical History and Medication sections. 
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Report Types 
Ambulatory Blood Pressure Report 

The Ambulatory Blood Pressure Report page contains the following sections: 

• Header: Contains the credentials of the specialist reviewing the report. 
• Patient Information: Displays patient details relevant to the report. 
• Interpretive Summary: An automatically generated summary based on the test results. 
• Blood Pressure Graph: Visual representation of the patient's blood pressure over time. 
• Brachial BP Results Table: Summarizes brachial blood pressure measurements. 
• Physician Comments: Section for physician observations and notes. 
• Signatures: Area for signatures to validate the report. 

 
 

BP Graph (Middle Pane) 
See following Figure. 
The left-hand Y-axis with the mmHg units applies to systolic, diastolic, and mean BP values. 
The X-axis applies to time (hour). 
The daily intervals are highlighted (Awake Time in white, Asleep Time in light blue). 
Day counts all daytime intervals together. 
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Note 

You can set these values when preparing for a new ABPM test. 

 

The blue-line (Y-axis) with the HR units (BPM) applies to heart rate. 
 

Brachial BP Results (Bottom Pane) 
See following Figure. 

 
Period – Overall (awake & asleep periods) Awake Period, Asleep Period, Dipping (the 
percentage of low systolic and diastolic BP during night relative to daytime), and Morning 
Surge (the increase in systolic and diastolic BP during early morning hours relative to 
nighttime) 
Time – from hour - to hour (number of hours) 
Samples – The number of samples 
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BP SYS [mmHg]: Average (+/-Std.Dev), Max, Min – Average systolic BP in mmHg 
(±BP deviation), Maximum and Minimum values. 
BP DIA [mmHg] (+/-Std.Dev) – Average diastolic BP in mmHg (±BP deviation), 
Maximum and Minimum values. 
Average HR BPM (+/-Std.Dev) – Average HR in BPM (±BPM deviation) 
BP Load Sys (%) –Percentage of abnormally elevated systolic BP readings relative to normal 
BP Load Dia (%) –Percentage of abnormally elevated diastolic BP readings relative to normal 
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Patient Information 
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BP Profile 

 
The right-hand Y-axis with mmHg units applies to Systolic, Diastolic, and mean BP values. 

The left-hand Y-axis with the BPM units applies to heart rate (HR). 

The X-axis applies to time. 

The daily intervals are highlighted (Awake Time in white, Asleep Time in gray). 

Day counts all three daytime intervals together. 
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Bar Chart 

 
In this profile, the following values of the test series are displayed graphically in a bar chart 
as a function of time: 
Systolic values 
Median values 
Diastolic values 
Heart rate 
The right-hand BP Y-axis with mmHg units applies to Systolic, Diastolic, and mean BP values. 
The left-hand HR Y-axis with BPM units applies to heart rate. 
The X-axis applies to time (hours). 
The daily intervals are highlighted (Awake Time in white, Asleep Time in gray). 
Day counts all three daytime intervals together. 

 
Note 

You can set these values when preparing for a new ABPM Test. 
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Measurements 

 

The measurement in red indicates exceeding the defined limit for both systolic and diastolic BP. 

The Notes column in the Measurements table is important, notifying the user about 
error(s) occurred during taking measurement(s). 
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Diastolic vs Systolic Graph 
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This diagram shows the correlation of diastolic to systolic blood pressure (see following Figure). 
Each       and       corresponds to one measurement. You can see the BP limits as horizontal 
(Systolic) and vertical (Diastolic) set-point curves. 

 

 

The       dots are BP measurements taken during the Awake Time and the blue chart line represents the 
average of the blue dots. 
The       squares are BP measurements taken during the Asleep Time and the green chart line represents 
the average of the green squares. 

 

AASI: 0.14 – Ambulatory Arterial Stiffness Index, calculated from a set of data collected during a 24-hour 
ABPM, is defined as 1 minus the regression slope of diastolic on systolic blood pressure (BP) values. 
Average (SYS,DIA): (140.94) – Overall average of Systolic and Diastolic BP 
Correlation Coefficient: r=0.85 – A numerical measure of correlation between Systolic and Diastolic 
BPs, meaning a statistical relationship between two variables. 

 

Awake Time: 
Average (SYS,DIA): (144.99) – Average of Systolic and Diastolic BP during Awake Time 
DIA=0.69SYS-0.6 – Awake-Time graph equation 

 

Asleep Time: 
Average (SYS,DIA): (127.80) – Average of Systolic and Diastolic BP during Asleep Time 
DIA=0.69SYS-0.6 – Asleep-Time graph equation 
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Pie Chart 

 
The values of one measurement series are analyzed according to the BP limits set. 

The Systolic and Diastolic pie charts show the percentages of measurements as follows: 
Acceptable  
Too High  
Normal  



D/N: NV-400.2790.050|Rev02 NEMS-A Instructions for Use Page 146 of 166 
 

Summary Report 
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Working with the NBP One ABPM Recorder 
The following operations are specific for operating NEMS-A with the NBP One ABPM recorder: 

Preparing NBP One Recorder for New ABPM Test. 

Downloading ABPM Recording from NBP One Recorder. 

Reviewing ABPM Recording in NEMS-A. 

Preparing NBP One Recorder for New ABPM Test 
1. Make sure the NBP One recorder is connected to the PC USB port. 

2. To open the Patients Screen, click the                      tab and search for the patient 

whose NBP One recorder you want to prepare. 

3. Click on the selected patient on the list (the row is highlighted in blue) – see Figure below. 

 
Click the                   button, and then select the                   test type. 

The Patient Details Dialog Box is displayed. 

 
Figure 194: Patient Details Dialog Box 

Validate the patient details, configure the ABPM protocol settings, select the Referring MD 

and Technician from drop-down menus, and then click the                  button. 

Wait until the Prepare operation is finished. 

Disconnect the NBP One recorder from the PC. 
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Downloading ABPM Recording from NBP One Recorder 
1. Make sure the NBP One recorder is connected to the PC USB port. 

Click the                      tab, and then click the                                button. 

Validate or edit the patient details, and then click the                                button. 

When downloading is finished, the Download Complete Dialog Box is displayed  
(see Figure below). 

 
After the Download Complete Dialog Box appears, disconnect the NBP One recorder 
from the PC. 
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Reviewing ABPM Recording in NEMS-A 

1. Click the                    tab. 

2. Search for a specific recording. 

3. Select (highlight) the recording, and then click the                button. 

 
Figure 195: Selecting ABPM Test for Review 

The ABPM Review Screen is displayed. 

 
Figure 196: ABPM Review Screen 

1. BP Measurements Table 
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2. BP Graph 

Review the ABPM measurements and write comments in the                                          field. 

To generate the report preview, click the                         button above the ABPM 
measurement list. 

The ABPM Report Preview is displayed. 

 
Figure 197: ABPM Report Preview 

To view the report, click the                     button. 
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The ABPM Report is displayed. 

 
Figure 198: ABPM Report 

To print the report, click the              button. 

To export the BP measurements table to Excel file, click the                button, which 

prompts to location on your PC for saving the Excel file. 
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To customize the report, click the                             button. 

The Customization Dialog Box is displayed. 

 
Figure 199: Customization Dialog Box 

Select the items for inclusion in the report from the drop-down list, and click                      . 

To send the report by email, click the                      button, which opens a message in MS Outlook 

with the report PDF ready to be sent. 

To save the report PDF, click the                      button, which prompts to location on your 

PC for saving the PDF file. 

Finally, click the                    button to return to the Patient List main screen. 
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Working with the NBP-24 NG ABPM Recorder 
Preparing NBP-24 NG Recorder for New ABPM Test 
1. Make sure the NBP-24 NG recorder is connected to the PC USB port. 

Select the patient from the Patients Screen, click the                   button, and then select the  

test type. 

The Patient Details Dialog Box is displayed. 

 
Figure 200: Patient Details Dialog Box 

Validate the patient details, configure the ABPM protocol settings, and then click the  

               button. 

Disconnect the NBP-24 NG recorder from the PC. 

Downloading ABPM Recording from NBP-24 NG Recorder 
See Section Downloading ABPM Recording from NBP One Recorder. 

Reviewing ABPM Recording 

 
Note 

Reviewing ABPM recording is identical for NBP One and NBP-24 NG. 

See Section Reviewing ABPM Recording in NEMS-A. 
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Working with the HRV Application 
Select the patient from the Patients Screen, click the                   button, and then select the  

                test type. 
The Patient Data Dialog Box is displayed. 

 
Figure 201: Patient Data Dialog Box 

Validate the patient details and click                 . 

For detailed description, refer to the PC-ECG IFU – Heart Rate Variability (HRV) Chapter. 

https://www.noravmedical.com/_files/ugd/954eab_901ba8b5ce954e17871e4162fd7d9028.pdf
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Working with the Late Potential Application 
1. Select the patient from the Patients screen, click the                   button, and then select the  

              test type. 

The Patient Data Dialog Box is displayed. 

 
Figure 202: Patient Data Dialog Box 

Validate the patient details and click                 . 

For detailed description, refer to the PC-ECG IFU – Late Potential Signal Averaging Chapter. 

https://www.noravmedical.com/_files/ugd/954eab_901ba8b5ce954e17871e4162fd7d9028.pdf
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Working with the ECG Monitoring Application 
1. Select the patient from the Patients Screen, click the                   button, and then select the  

                         test type. 

The Patient Data Dialog Box is displayed. 

 
Figure 203: Patient Data Dialog Box 

Validate the patient details and click                 . 

For detailed description, refer to the PC-ECG IFU – Monitoring ECG Chapter. 

https://www.noravmedical.com/_files/ugd/954eab_901ba8b5ce954e17871e4162fd7d9028.pdf
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Working with the MiniSpir Spirometer 
For detailed instructions, refer to the MIR Spiro Software User Manual or the built-in 
application Help. 

Before working with the MiniSpir device, install the spirometry software on your PC. After 
installation, adjust the software settings in the NEMS-A application. 

1. Click        on the Toolbar. The Setup Dialog Box is displayed (see Figure 204). 

 
Figure 204: Setup Dialog Box 

2. To adjust the software settings, click          , then browse and select the MIR SPIRO.exe file 
on your PC. Click Open.  

3. The Spirometer path will be updated. Do not remove “/GDT” from the Spirometer path. 

4. Click OK to save the changes. 

 

To perform a spirometry test using this application: 

1. Connect the MiniSpir device to your PC via USB. 

2. Select the patient from the Patients Screen, click the                   button, and then select the 

Spirometer test type. The software opens, displaying the main screen. Ensure that the 

patient’s Date of Birth, Height, and Weight values are entered before performing the test. 

3. Select the required test type in the right pane (for example, FVC or SVC). The test screen 
opens (see Figure 205). 
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Figure 205: Spirometry Software Main Screen 

4. Click START to perform the test. 

5.  When the test is complete, or when the TEST ENDED button is clicked, the test report 
screen appears. 

6. Close the application. The SPIRO test appears in the NEMS-Q Records tab. 

7. To review the test (physician only): 

Click the                    tab and select (highlight) a                  recording. 

The SPIRO Recording Selection for Review Screen is displayed. 

 
Figure 206: SPIRO Recording Selection for Review 

Click the                 button. The spirometry software main screen is displayed. 

8. Review the test within the application. 

9. When the review is complete, close the application. 
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Working with the NSpiro™ Application 
For detailed description, refer to the NSpiro™ Quick Guide and the NSpiro™ Software IFU. 

Before working with the NSpiro™ device, install the NSpiro™ software on your PC  
(see the NSpiro™ Software IFU Section 1.3 – Installing the Software). 

After the NSpiro™ Software is installed, continue in NEMS-A as follows. 

1. Click        on the Toolbar. 

The Setup Dialog Box is displayed (see Figure 204). 

2. To open the NSpiro™ software, click          , then browse and select the NSPIRO.exe file 
on your PC. 

3. Click                  . 

4. Select the patient from the Patients Screen, click the                   button, and then select the 
Spirometer test type. 

The NSpiro™ Software is opened, displaying the NSpiro™ Main Screen. 

5. Calibrate the device (see the NSpiro™ Quick Guide Chapter 4 – Calibrating the Device). 

6. Enter patient details (see the NSpiro™ Quick Guide Chapter 5 – Enter Patient Details). 

7. Perform the test (see the NSpiro™ Quick Guide Chapter 6 – Perform a Test). 

8.  To review the test (physician only): 

a) Click the                    tab and select (highlight) a                  recording. The SPIRO 
Recording Selection for Review Screen is displayed (see Error! Reference source not 
found.). 

b) Click the                 button. 

9. The NSpiro™ Main Screen is displayed. 

10. Review the test (see the NSpiro™ Quick Guide Chapter 7 – Review Tests). 

11. Print the report (see the NSpiro™ Quick Guide Chapter 8 – Print Final Report). 

 

https://noravstorage.s3-eu-west-1.amazonaws.com/website/Manuals/Operation+Manuals/NSpiro/EN/NV54-QG004+-+NSpiro+Quick+Guide_EN.pdf
https://noravstorage.s3-eu-west-1.amazonaws.com/website/Manuals/Operation+Manuals/NSpiro/EN/IFU-NSpiroSOFTWARE-EN-V1301-Rev02.pdf
https://noravstorage.s3-eu-west-1.amazonaws.com/website/Manuals/Operation+Manuals/NSpiro/EN/IFU-NSpiroSOFTWARE-EN-V1301-Rev02.pdf
https://noravstorage.s3-eu-west-1.amazonaws.com/website/Manuals/Operation+Manuals/NSpiro/EN/NV54-QG004+-+NSpiro+Quick+Guide_EN.pdf
https://noravstorage.s3-eu-west-1.amazonaws.com/website/Manuals/Operation+Manuals/NSpiro/EN/NV54-QG004+-+NSpiro+Quick+Guide_EN.pdf
https://noravstorage.s3-eu-west-1.amazonaws.com/website/Manuals/Operation+Manuals/NSpiro/EN/NV54-QG004+-+NSpiro+Quick+Guide_EN.pdf
https://noravstorage.s3-eu-west-1.amazonaws.com/website/Manuals/Operation+Manuals/NSpiro/EN/NV54-QG004+-+NSpiro+Quick+Guide_EN.pdf
https://noravstorage.s3-eu-west-1.amazonaws.com/website/Manuals/Operation+Manuals/NSpiro/EN/NV54-QG004+-+NSpiro+Quick+Guide_EN.pdf
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Troubleshooting 
Problem Cause Corrective Action 

When attempting to perform an action, 
an onscreen error message appears 
indicating there is a failure in connecting 
database. 

Network connection. If you are working on the network, consult your 
system administrator and then examine the 
network connection. 

Encrypted NBP-24 NG devices 
stopped connecting with PC during 
work. 

 Uninstall the COM port, used for connection 
with device. 

Device is not connected… message is 
displayed when preparing the  
NBP-24 NG device or downloading 
from it in Windows 11. 

Prolific PL2303TA USB 
to Serial driver is not 
supported by Windows 11 
or later. 

Open Device Manager, where the  
…not supported… message is displayed and 
update the driver or reinstall it. 
A new driver can be easily found on the 
Internet (or provided by Norav). 
The action may be required for each new used 
USB port or USB cable of the  
NBP-24 NG device. 

How to check HASP when 
license-related issues occur: 
(software key not found, missing some 
permissions). 

HASP is connected to PC 
or server, but the 
application cannot be 
opened or used correctly. 

The first-line test for both HASP and 
NetHASP issues is checking the 
http://localhost:1947 address via Internet 
browser. Here you can immediately see all 
HASP and NetHASP keys visible on a 
current PC locally and in network.  
The Norav dongle VendorID=47559. 

To check the licenses on Norav 
HASP/NetHASP dongles, we use the 
HaspLicenseRadar tool. Use is simple:  
Run the tool on the computer where the 
HASP/NetHASP key is connected to USB. 
This shows the list of licenses on the dongle. 
Ask Support team for the tool, if needed. 
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Appendix – Interfacing with Information Systems 
There are several ways to exchange information between NEMS-A and Hospital Information 
System (HIS). These are described below. 

Demographic Data 
HIS Preparing Patient Demographic Data for NEMS 
This uses a text file named PatientFile.ini. The file location is defined in NEMS-A setup.  
The file consists of patient data segments. Maximum length is 999 patients. 

PatientFile.ini Format 
Field Name Type Max. Length Format Comments 

[PatientDataXXX] Header Fixed [PatientData001] to [PatientData999] Segment counter 

ID Alphanumeric 30 Cannot contain \ / ? * ″ < > | _ symbols ID number (MRN) 

LastName Alphanumeric 30 Cannot contain \ / ? * ″ < > | _ symbols  

FirstName Alphanumeric 30 Cannot contain \ / ? * ″ < > | _ symbols  

BirthDay Number 2 01 to 31 or 1 to 31  

BirthMonth Number 2 01 to 12 or 1 to 12  

BirthYear Number 4 YYYY  

Sex Number 1 0 – Female, 1 – Male, 2 – Undefined  

Weight Number 3 0 to 500 (integer) kilograms 

Height Number 3 0 to 300 (integer) centimeters 

Address String 256 Any text  

Phone1 String 15 Any text  

Phone2 String 15 Any text  

Fax String 15 Any text  

E-Mail String 30 Any text  

Medications String 256 Any text  

Other String 256 Any text Any textual data 

TechName String 30 Cannot contain \ / ? * ″ < > | _ symbols Performing person 

PhysName String 30 Cannot contain \ / ? * ″ < > | _ symbols Attending physician 

IDR Alphanumeric 30 Cannot contain \ / ? * ″ < > | _ symbols Accession number 

Case_ID Alphanumeric 30 Cannot contain \ / ? * ″ < > | _ symbols Visit number 

Employee_Resp String 30 Any text  

Type String 30 ECG, Stress, Rest, Holter, ABPM, SPIRO Examination type 

ScheduledDate Number 12 YYYYMMDDHHMM Scheduled date 

Status Number 1 0 – scheduled, 1 – in process, 2 – completed Examination status 

Location String 30 Any text Examination office 

ReferPhys String 30 Any text Reference physician 

AlternateID String 30 Cannot contain \ / ? * ″ < > | _ symbols Alternate ID number 

At least one of the ID, LastName, or FirstName fields must be completed. 
When all these fields are blank, the section of this patient is ignored. 
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Example 
[PatientData002] 
ID=10002 
LastName=Johnson 
FirstName=Mary 
BirthDay=30 
BirthMonth=11 
BirthYear=1948 
Sex=1 
Weight=69 
Height=171 
Address=25 Wightman Street, San Diego, USA 
Phone1=858-6577000 
Phone2=858-6577001 
Fax=858-6576000 
E-Mail=b@a.com 
Medications=aspirin, analgen 
Other=OtherDetail-2 
TechName=Technician@21 
PhysName=Physician@21 
IDR=1243531 
Case_Id=Case#2 
Employee_Resp=Employee_Resp#21 
Type=Stress 
ScheduledDate=201510161440 
Status=1 
Location=UC San Diego Medical Center 

Importing ECG Recordings with Patient Data Validation 
When importing ECG recordings containing only the patient ID or the Order Number, 
NEMS-A can retrieve the patient's name by obtaining it from the database. 

To setup the ECG recordings import with patient data validation, edit the 
Settings.xml configuration file as follows: 

1. Set the <ValidatePatient enabled=″TRUE″> 

Set the validation key field: 
To check patient data by ID, set: 
<CheckID>TRUE</CheckID> 
<CheckOrderID>FALSE</CheckOrderID> 
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Importing PDF Reports 
NEMS-A can accept PDF reports created by external systems. The patient and test 
information should be included in the PDF filename. 

External PDF reports should be received to the NEMS-A database Import folder. 

The import folder path is described in the <InboxFileDirectory> parameter of the 
Settings.xml configuration file. 

Three filename formats are available for importing PDF reports. 

PDF Report Filename Format #1 

Filename format: ORDER_ID_LAST_FIRST_DOB_DATE_TIME_TYPE.PDF 
Where: 

Example: 
0001_12345_Vivaldi_Antonio_04-03-1978_15.07.2015_12~15~21_STRESS.PDF 

PDF Report Filename Format #2 

Filename format: ORDER_ID_FIRST_LAST_DOB_SEX_DATETIME_TYPE.PDF 
Where: 

Example: 
000987_123_Mary_O'Hara_19691129_F_20131008094317_HOLTER.PDF 

ORDER Examination identifier (order number, accession number, or other) 

ID Patient ID number 

LAST Patient last name 

FIRST Patient first name 

DOB Patient birth date in format DD-MM-YYYY 

DATE Examination date in format DD.MM.YYYY 

TIME Examination hour in format HH~MM~SS 

TYPE Can be REST, STRESS, HOLTER, ABPM, or SPIRO 

ORDER Examination identifier (order number, accession number, or other) 

ID Patient ID number 

FIRST Patient first name 

LAST Patient last name 

DOB Patient birth date in format DD-MM-YYYY 

SEX Patient gender: M – male, F – female, U – undefined 

DATETIME Examination date in format YYYYMMDDHHMMSS 

TYPE Can be REST, STRESS, HOLTER, ABPM, or SPIRO 
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PDF Report Filename Format #3 (ABPM Reports only) 

Filename format: ID_LAST_FIRST_DOB_DATE_TIME_TYPE.PDF 
Where: 

Example: 
999999_Doe_John_1945-08-02_2007-05-29_12-18_24hABPM.pdf 

Exporting PDF Reports 
NEMS-A can export the PDF reports to be accepted by external systems. The patient and 
test information are included in the PDF filename. 

The export folder path is described by <OutboxFileDirectory> parameter of Settings.xml 
configuration file. 

PDF reports export filename format is according to Format #2 (see Section PDF Report 
Filename Format #2). 

ID Patient ID number 

LAST Patient last name 

FIRST Patient first name 

DOB Patient birth date in format DD-MM-YYYY 

DATE Examination date in format YYYY-MM-DD 

TIME Examination hour in format HH-MM 

TYPE Can be 24hABPM, OfficeBP, HomeBP, or 24hPWA 
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GDT Interface 
GDT interface enables NEMS-A to communicate with EMR programs. The patient is always 
selected in the EMR program. NEMS-A should be called after the patient's electronic recording 
file in the EMR program is selected. Patient data management is done in the EMR program, 
whereas medical signals (ECG, ABPM, spirometry data, etc.) are handled in NEMS-A. 
New procedures are created via NEMS-A. Existing procedures can be edited via NEMS-A. 
Upon completion of a new procedure or after review of the existing procedure, the EMR 
program adopts the most important data of all new and edited procedures. 

Calling NEMS-A from EMR via GDT 
Adjust the EMR configuration to call the NEMS-A Client with /GDT command line switch. 
Example: C:\Program Files (x86)\Norav Medical\NEMS\EMSApplication.exe /GDT 

Functionality 
1. EMR prepares a GDT command file and then places it in the GDT Inbound folder. 
Launch the NEMS-A Client application with /GDT command line switch. 
NEMS-A starts and performs the procedure defined in the GDT command file. 
After the procedure is complete the GDT report is generated in the GDT Outbound folder. 
Exit the NEMS-A Client application, which can be done automatically or by operator. 

Opening Patient Data in NEMS-A Interface via GDT 
1. Initiate the EMR program and select a patient. 
Perform Open Patient History whatever command in the EMR program interface. 
NEMS-A starts with the selected patient record or automatically creates a new patient record.  
Start new procedure or review existing recordings in appropriate software application. 

When the action is complete, the software application sends results to the EMR. 
The EMR program automatically adopts the updated data. 

Performing New Test via GDT 
1. Initiate the EMR program and select a patient. 
Start the desired procedure in the EMR interface that initiates the NEMS-A application. 

NEMS-A displays the initiated procedure details to be validated by the user. 
The user must confirm the selected procedure or select another procedure type for the patient. 
Upon confirmation of the procedure type, NEMS-A starts the appropriate software application. 

Perform the procedure (acquire ECG, spirometry test, prepare ABPM recorder, etc.). 
When the procedure is complete, the software application sends results to the EMR. 
The EMR program automatically adopts the new results. 

Displaying Existing Procedure via GDT 
1. Initiate the EMR program, select a patient, and then select the existing procedure from the list. 
Perform Review or Open whatever command in the EMR interface. 

This activates NEMS-A that displays the test details to be validated by the user. 
Open the selected record, review, and then save the record. 

When review is complete, the software application sends results to the EMR. 
The EMR program automatically adopts the updated review report. 
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Document History 
Version Date Updates Changed by 
1.0.0.0  IFU created  
2.7.5.0 Rev. 02 05.07.2023 Updated ABPM Reports and Graphs by removing all irrelevant measurements, 

unselected from the beginning of the test. 
Added functionality to Updated PDF Report for Rest and Stress tests after 
reviewing the records (adding Remarks or Conclusion) 

Alex K. 

2.7.5.0 Rev. 03 21.12.2023 Images updates to reflect the UI changes within certain screens. Anton B. 
2.7.6.0 28.12.2023 Added Multiple Report Date Format (Europe, USA), Header alignment to the 

Setup menu.  
Added Referring Physician, Reporting Physician and Technician drop-downs to the 
Review screen for ABPM (and to the reports)  . 
Added support for the new NH301 v4.0.0 Holter format (HL5) 

Anton B. 

2.7.7.0 03.09.2024 All changes are related to the Review ABPM screen: 
• Introduced the Interpretative summary, also within ABPM report. 
• Changed "Average" to “JNC7/AHA” thresholds + Custom option for 

the thresholds. 
• New layout for ABPM reports + Header centering 

Added new parameter - Morning BP Surge for ABPM Test Review screen and 
PDF Report 

Anton B. 

2.7.7.1 05.11.2024 • NR-314-P recorder support 
• Prepare device with existing study warning notification 
• Download from recorder (clear recorder memory notification) 
• NEMS ABPM Report front page changes (mainly header and footer 

areas) 

Anton B. 

2.7.8.0 30.04.2025 General Information section updated; Document reference information format 
updated; Preparing Holter Recorder for New Patient section updated (Check ECG 
section introduced). 

Anton B. 

2.7.8.0 Rev. 02 06.08.2025 General Information section update. Anton B. 
2.7.9.0 01.02.2026 Added MIR Spiro Software Intended Use section. Added Working with the 

MiniSpir Spirometer section. Updated the Opening Stress ECG Record for Review 
section. UK-Rep address updated. IFU download link updated. 

Anton B. 

2.7.9.0 Rev. 02 25.02.2026 Address section updated (UK-Rep), minor fixes. Anton B. 
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